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Introduction
RR-Track is a model train layout visualization application.  It is designed to easily enable anyone to create, view, 
and edit toy train layouts consisting of Z-, TT-, N- HO-, O-, O-27, G-, S, and standard/wide gauge track.  Using 
RR-Track you can create layout designs ranging from a simple loop to complex layouts such as that typified by 
the Lionel® 1948 showroom layout containing nearly 500 pieces of track and over 100 accessory and scenery 
items.

The number of track, accessory, scenery, and other items you place in your layout is only limited by your 
requirements and level of detail.  You can mix gauges and manufacturers as needed.  You can place accessory 
items from RR-Track's standard libraries or create your own using the built-in drawing tools.  As you are 
working, you can check the appearance of your creation using the 3D View module, and you check your layout 
design from proper operation ( or play train games) using the Simulation module.

If you are new to RR-Track, we suggest reading the Getting Started topic for a step-by-step introduction to 
layout design using RR-Track.  If you are a seasoned user, feel free to study any of the topics.  The Views topic 
discusses the different ways RR-Track can display your layout design.  Choose the How Do I link for quick 
access to a number of topics.

Regardless of your familiarity with previous versions of RR-Track, we urge you to read up on Track Laying Tips 
and the topic on Building Your Layout to the Plan.
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Tutorial:  Getting Started with RR-Track v5
In order to get started building your dream layout, the following tutorial will guide you step-by-step through the 
process of building an oval of track and then modifying it to add a turnout and spur.  Following that, further 
segments will show you how to elevate track, create bench units, add scenery, and finally run some trains.

Getting Started Part 1: Basic Track Laying
First, you must start RR-Track.  Do this by either (1) double-clicking its icon on the Windows Desktop , or (2) 
pressing the   Start   button  , choosing Programs and then RR-Track for Windows.  You can also double-click on 
an existing track layout file (extension .rrt) from the Windows Explorer;  Windows then automatically starts RR-
Track and opens that layout.

RR-Track creates several windows when you start it and 
open a layout file:  the main frame window, master layout 
window, and layout overview window.  RR-Track has two 
distinct classes of options that can be set from either the 
menu or dialogs reached from the menu.  These are global 
options (those that affect all layouts and are remembered 
between sessions) and layout options which affect only the 
active layout window (the one you are working on). Some of 
these are stored with the layout components and 
remembered between sessions while others can be set as 
defaults and affect all subsequent layout windows.  See 
global options dialog and layout options dialog for more 
information.

When you first start RR-Track, you are presented with a 
window like that at left.  Here you have a choice of (1) 
Creating a New Layout, (2) opening one of your Existing 

Layouts, or (3) choosing a layout from a list composed of your six most recent layouts as well as all of those in 
your My RR-Track Layouts folder.  You can also choose None of the Above.

Choose “I want to create a new layout”.  As soon as you do, you will see a window like that below.  This is the 
New Track Layout Wizard which will lead you through the 
process of setting up your first layout design.

(1) Set your layout size
First you must determine your starting layout size.  This will 
be the size of a rectangular area in which your actual layout 
design resides ( regardless of its shape).  In essence, this 
is the size of the sandbox in which you can start to work; 
you can always change the size later.  

Use the up/down spin buttons to set the width and depth.  
We want a width of 10ft and a depth of 7ft.  Then press the 
Next button...
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(2) Set your layout scale
Next, you want to set the scale of your layout.  The layout 
scale is used for things such as automatically setting the 
heights of user-drawn structures such as buildings, walls, 
and roads.  It does not affect the physical size of the track or 
accessories that you position on your layout.  

Choose O-scale and the press Next...

(3) Set your layout type
This is an easy one.  You can either choose a standard 
layout which includes predefined layers for track, scenery, 
roads, etc. or you can choose a plain layout which has only 
a single drawing layer defined.  

Choose “Standard Layout”, this will make it easier to 
separate various features of your layout for visibility 
purposes.  Then press Next....

(4) Set your layout shape
Now it gets a little more interesting.  RR-Track has the 
capability of creating predefined benches ( whose sizes 
you can change later) that will produce layouts that are 
simple like a single table, L-shaped, C-shaped, and 
perimeter layouts that go around the edges of your space.

We will leave the more complex shapes for another time, 
for right now, choose “single bench covering the entire 
layout area” and then press Next...
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(5) Set your layout name
Almost there. Here you have to choose a file name for your 
layout. We suggest typing “My First Layout” in the text box.  
Make sure the “use My Documents root” box is checked ( it 
should be); the list shows the existing RR-Track layouts in 
that folder. Don’t choose one of those names, you don’t 
want to overwrite any previous layout designs.

When you are finished specifying the layout file name, press 
the Done button.

As soon as you press the Done button, RR-Track creates a 
new layout based on the specifications you designated.  
You should see a master layout window that looks like that 
below.

There are five tabs corresponding to the five different views 
you can have of your layout design.  Of course there is no 

track for the trains to run on (yet), that comes next.  If you have a small screen and need the maximum space to 
work in, press the Maximize button at the upper right ( not the Minimize button).  If you do not maximize the 
master layout window, your screen should look similard.

The small window at the upper right 
shows an overview of your layout, 
with a small red rectangle denoting 
the area currently displayed in the 
Plan view ( right now we are zoomed 
out to show the entire layout so there 
is no red rectangle).

There is a menu bar across the top of 
the RR-Track application window.   
For a Plan View this menu has pull 
down sub-menus File, Edit, Action, 
View, Track, Objects, Fonts, 
Grades, Library, Options, Window, 
and Help.

The Action menu is disabled unless 
you have selected some track or 
object that may be acted upon.  If the 
overview window isn’t visible, pull 
down the View menu and choose 
Show Over View. Move the cursor to 
the overview window and right click 
with the mouse.  From the pop up 
menu choose Dock Upper Right).

Note the status bar on the bottom of 
the RR-Track application window.  This is not just for information purposes but allows quick access to a number 
of RR-Track options and parameters that may need changing as the situation requires.  For example, the layer 
list display near the center should say ‘track 1’.  This signifies that new items are added to the ‘track 1’ layer.   
For further information on RR-Track status bars, see the essay on using the status bar.

We are going to construct a layout using Lionel O-gauge track.  We could use some other track such as LGB G 
or Atlas c.100 HO, but all configurations of RR-Track contain a Lionel O library, and the principles of 
construction are the same, regardless of the track library.  Pull down the Library menu and choose Lionel O.  
RR-Track places a check mark next to this item to indicate that Lionel O is the current track library.  Pull down 
the Options menu and check Detailed Track Render if it is not already checked.  While you have the Options 
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menu down, verify that Selections Include Joints is checked.  If it is not, check it.  Make sure that Detailed 
Track Render and Label Track are also checked.

Now pull down the Options menu and choose Options.  This will 
cause RR-Track to display the Global Options dialog, like that at 
left.  The Global Options dialog has eight tabbed pages, but the 
Track Laying tab is the one we want to look at first.  Make sure that 
Allow Track Breakaways, Autojoin Track, Auto-close Loops, and 
Proximity Joining are all checked.  Once you have done this, 
select the Miscellaneous tab and verify that Fly  Over Item ID is 
checked. 

When you have verified this, press the OK button.

Next, right-click somewhere over the empty layout to bring up a 
shortcut menu. From this menu choose Layout Options ( towards 
the bottom ). This will bring up the Layout Options dialog.  Click on 
the Coordinates tab and make sure that Detailed is chosen in the 
Symbols & Details group, and that label track sections is checked 
in the Track Labeling group.  Then press OK.   Now it is on the 
laying some track.

Starting a Loop

Let us place the first piece of track.  Pull down the Track menu and select O-straight -> Lionel single from the 
list of straight track sections.  The cursor will change  to 

Without clicking the left mouse button, move the track to somewhere in the lower left region of the layout, then 
depress and release the left mouse button (this depressing and releasing of the mouse button is termed 
'releasing the track').  The point at which the origin of the track section is placed is the tip of the cursor arrow. 
RR-Track draws a straight section of Lionel track at this point, and labels the track '6-65500'.  Since you are no 
longer placing a track section, the cursor returns to the Windows arrow.  Now repeat this process, except use the 
Last Track command from the Track menu to get another piece of 10 inch straight track.  Bring the left side of 
this section near (within 12 inches) of the right side of the previous track section, and click (depress and release) 
the left mouse button.  The new piece of track immediately attaches itself to the first piece, forming a 
combination of two straight pieces of 10 inch Lionel track.  Again, repeat this process, but this time move the 
cursor over an empty area of the layout (an area that does not have the two track sections beneath the cursor) 
and double-click the left mouse button.  Another straight section of track appears under the cursor.  Move this to 
one end of the other two track sections and click the left mouse button so that the new section automatically 

joins itself to the first two sections.  Finally, move the cursor to the 
right side of the status bar near the bottom of the screen and place it 
over the button labeled 'single straight' and press the button.  You will 
have yet another section of 10 inch straight track appear under the 
cursor.  Move this over to the first three and join it to them.  At this 

point the screen should look something like that at left. You have assembled four sections of track using all four 
ways of calling up a piece of track ( Track menu -> O-Straight -> Lionel SIngle, Track menu -> Last Track, left 
mouse double-click, and Last Item list). 

Now it is time to tackle building the first curve.  We will 
build a semi-circular (180°) curve using four sections of O-
31 curved track.  Pull down the Track menu and select O-
Curve -> O-31(modern)45° L, bring the left side of the 
curve down near the right end of the group of four straight 
track sections, and release it, automatically joining the 
curve to the four sections of straight track.  To bring up 
another curve, use the double-click shortcut; double-click 
the left mouse button in a blank area to bring up another 
O-31 curve, bring the curve's left end up near the 
unattached end of the previous curve, and release to join 
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the new curve to the previous curve.  Repeat this process two more time, giving you four O-31 curves in all, 
joined to each other to form a semicircle, with one end joined to the four straight track sections.  The layout 
should now look like this, resembling a candy cane.

If your layout does not look similar to that in the figure, go back through the previous section and see what you 
left out.  If the last track section was joined in an errant manner (which is any manner that is not that way you 
wanted) you select the Step Back item on the Edit menu until you remove the last piece of track.

Before we go on, take a moment to place the mouse pointer over one of the straight track sections.  RR-Track 
displays a small window which shows you what kind of track you are over, in this case '  Lionel single straight  '  , 
and the layer this track section occupies ( in this case <<track 1>>).  Move the mouse pointer over one of the 
curved track sections and stop it for a second.  The hint name that appears now says '  Lionel O-31 curve 45°  '.  
Simply by pausing the mouse pointer over a track section you can get information on that track.  If you pause 
over a cut piece of track, the hint name also tells you the length, for a cut curve track the radius and arc angle 
(for a piece of flexible track RR-Track shows the length, minimum radius, and arc angle between the ends).  As 
you change the extended selection mode ( how RR-Track makes multiple selections ), the hint window will also 
give height and grade information. 

Move the cursor to the view tabs and click 
on the tab labeled Component View.  RR-
Track switches to a view of the components 
that make up your layout ( there are five 
distinct views of, or ways of looking at, a 
layout).  The top level tab, labeled All, 
should display eight total track sections; four 
10 inch straight sections and four O-31 
curve sections. 

For your information, both left- and right-
hand curves of a given radius and arc are 
identical; they are both included to make it a 
bit easier for you when placing new pieces 
of track.  Needless to say, left- and right-
hand turnouts are not identical and are listed 
as separate components in the layout item 
list.  The All tab of in Component VIew 
shows a summary of all components in the 
layout;  individual manufacturers or layer 
tabs are also present, further breaking down 
the component details.  You can get more information on the utility of Component View by studying it's help topic.

If you do not have four straight sections and four curved sections of 
track, please add/delete sections as necessary, by switching back to 
Plan View.  When finished, you can switch back to Plan View by clicking 
the Plan View tab.

Now pull down the View menu and choose Show Select List.  The 
Selected Items window should have nothing listed because we have 
selected no track sections.  Move the cursor over one of the straight 
sections of track and single-click it with the left mouse button (any of the 
four will do for this demo).  The track section you clicked on highlights in 

red, and the Selected Items window now shows a quantity of one Lionel 10 inch straight track sections.  Move 
the cursor over another of the straight sections of track and double-click the left mouse button.  This action, if 
successful, causes all 8 of the track sections to highlight.  If you look at the Selected Items window, it now looks 
like that at left.

There are four Lionel O single straight sections and four Lionel O O-31 curved sections of track listed with sub-
lengths of 40.00 inches and 44.92 inches, and a total of 84.9 inches which is approximately 7 O-gauge cars (O-
gauge cars are taken to be about 12 inches in length on average). 
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Note:  as you move the cursor over sections of track, the normal arrow changes to  indicating that 

you are over a track section.  This is a handy visual cue that lets you know when clicking the mouse will 
or will not select a track section.  It is also worth noting that the arrow cursor will change to other cursors 
when you are over accessories, objects, edit points, and status bar pop up lists.  These cursors will be 
somewhat grayed out if the item you are over cannot be selected because it is not in an active layer.  For 
more information, see the appendix on RR-Track Cursors.

Move the cursor over the + button next to the Lionel O single straight heading and left click it.  The entry expands 
to show all of the track sections of that type that are selected and their individual lengths.

In this case, all of the lengths are identical, but if these were custom cut to length sections of track, RR-Track 
shows the actual length for each track section.  The Selected Items window is a good way to see if a given 
stretch of track is long enough to accommodate the train you want to store on it, or use as a passing siding ( you 
can also test this directly by switching to Simulation View and setting up a test train, but that is a topic further 
along in the tutorial).  You can also get the sum total length of cut track sections in this manner, letting you 
calculate how much track will be needed to create them.

Move the cursor back to one of the highlighted sections of straight track and double-click it again with the left 
mouse button.  The selected track sections return to the one section beneath the cursor; this result is reflected in 
the Selected Items window.  You can close the Selected Items window now, and deselect the highlighted track by 
clicking the left mouse button in a blank area of the layout.

Important note: you just moved between choosing a single section of track and choosing all of the 
connected track sections simply by single-clicking or double-clicking the left mouse button.  Many times 
your are interested in carrying out some action on individual track sections, while at other times you want 
to grab the entire, contiguous set (for moving them as a group or rotating, for example).  The ability to 
move back and forth between these capabilities is controlled by whether you single-click or double-click 
on a track section when selecting it.  For more information see the essay on selecting items.

Single-clicking selects only the item under the cursor, while double-clicking selects that track section and all of 
the others that are joined to it in some manner, either physically, electrically, or in elevation (this response is 
determined by the Selections Include Joints / Selections Include Blocks / Selections Include Grades items 
on the Options menu).  This is called extended selecting.  The current extended selection mode may be found 
by 

• (1) pulling down the Options menu and checking on of these items, or 

• (2) by using the status bar.  It is a good practice to glance at the status bar from time to time to check on 
the state of these features since they control what happens when you double-click with the left mouse 
button. 

As you might expect, we are going to complete the oval of track by using four more straight sections and four 
more curved sections, similar to what you would find under the Christmas Tree in a magazine ad out of the 
1950's.  The most straightforward way of accomplishing this is to repeat the process just carried out by 
consecutively selecting four more 10 inch straight track sections and four more O-31 curves.  A faster way, the 
one we will use, is to:

1. copy the existing track.
2. paste it back into the layout.
3. rotate it 180°
4. join it to the first cane  shaped set of track, and then
5. close the track loop.
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We start by selecting all of the track.  Place the cursor over 
one of the 8 contiguous track sections (watch for the  

cursor) and double-click the left mouse button, highlighting 
all 8 track sections. Pull down the Edit menu and select 
Copy ( or click the right mouse button and select Copy 
from the shortcut menu).  You have now copied the 8 joined 
track sections into the RR-Track clipboard.  Next, we move 
to step two and paste the track back into the layout.  Pull 
down the Edit menu and choose Paste.  The just-
duplicated cane shaped set of track should now be 
somewhere in the upper left portion of the layout, 
highlighted in red.  It is worth mentioning that RR-Track 
has a Duplicate command which combines both Copy and 

Paste into one operation; we could just as well have done that.

At this point, we could pull down the Action menu and select Rotate.. in order to rotate the track into proper 
orientation to complete the oval loop, but there is a simpler and faster method.  We will make use of the 
automatic track joining capabilities of RR-Track.  Place the cursor over the left most straight section of track ( the 
far end section) and depress and hold the left mouse button down (remember to let the cursor help you out). 
After sometime like 1/2 second the cursor changes to   indicating that you can now move the track sections 

around the layout simply by dragging them with the mouse.  While continuing to hold down the left mouse button 
drag the free end of the left most straight section to within one track width ( in this case 1.25 inches) of the free 
end of the end curved section of the non-highlighted track (see moving items for more details).

Note:  while RR-Track has a capture distance for joining of 12 inches when adding new track, the 
capture distance changes to 1.25 inches when joining existing track, that is track sections already on the 
layout.  The capture distance for all track libraries is one track width when joining existing track.  This 
change in the capture distance is to avoid unwanted or unanticipated joining when manipulating track in 
busy areas.  These distances apply to O-scale, the actual distances are 10X track width for adding new 
track and 1X track width for moving existing track, so for HO you would have to move it within 0.625 
inches or one track width.

When you have them close enough ( 1X track width ), release the left mouse button.  RR-Track automatically 
rotates and joins the highlighted track sections to the existing track sections.

It also finds the other free end, notices that it is close 
enough to join, and joins that end as well, completing the 
loop.  Your layout should now look like that at left, a 
complete oval of 16 track sections, 8 straight sections and 8 
curves.

There, you are done with creating your first loop of track 
using RR-Track.  In this first part of the RR-Track Tutorial 
you have learned how to create a new layout, how to set up 
your track joining and display options, how to add track in 
four different manners ( and there is a fifth and sixth method 

we have not yet mentioned ) and how to copy/paste track to speed up the track laying process.
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Getting Started Part 2:  Expanding and Modifying
In the first part of the RR-Track Tutorial you learned to create an new layout and use the various methods of 
adding track to a layout to create a simple loop.  Now we are going to modify that simple loop ( after all watching 
trains go around a simple loop is pretty boring after a few minutes, even in Simulation View). 

Adding a Turnout and Spur Track

Start by moving the mouse pointer over the O-31 curve at the lower right (watch the cursor change to show 
when you are over it) and select it by clicking the left mouse button ( see selecting items) and holding it down. 
After a short pause, the curve track highlights and the cursor changes to  indicating that you can now begin 

to move this section. 

While continuing to hold down the left mouse button, drag this curve away from the others about 1/10 of the 
screen width (over to the middle of the loop, say) and then release the left mouse button. RR-Track breaks the 
track connections and lets you move the curve to its new position.  The single section of curved track should be 
highlighted as shown at right.  There will now be a gap in the oval where the curved track used to be.  Zoom in 
on the gap by pulling down the View menu and choosing 
Zoom In 2X.  Center the zoom rectangle on the gap in the 
oval, and single-click the left mouse button ( you can also 
right-click to get a shortcut menu and choose Zoom In 2X ).

Next, pull down the Track menu and choose O-Turnouts -> 
O-31(modern) 45° L.  Place the turnout near the gap as 
close as you comfortably can so that the spur end of the 
turnout is near the free end of the O-31 curve track and the 
turnout entrance is near the free end of the straight track and 
release it.  RR-Track joins the turnout to the oval, and 
completes the loop since two ends of the turnout join to the two free ends of the gap in the oval.  RR-Track does 
this by either proximity joining or automatic loop closing since both of these options were selected before we 
started.

Important note:  you removed the curved section from the existing oval by using a continuous click-hold 
mouse button-drag-release motion.  You could just as easily reinserted the curved section you removed 
by reversing this process:  selecting and dragging the curved section back to the gap in the oval, and 
releasing it when the ends were within 1.25" of the gap in the oval.  Get used to this; it makes it very 
easy to rearrange track layouts, something useful when you are trying out new configurations, or trying 
to find the best arrangement of curved and straight track to cover part of your layout.

Your layout should now resemble that at right.

Now we move on to add the spur loop.  From the Track menu 
select O-curve -> O-31(modern) 45° L and place it near the 
turnout's free end (this is the thru track).  Make sure you bring 
the left side of the curve up to the free end.  Click the left 
mouse button and join the two.  Then, choose another O-31 
curve (we will leave the method up to you) and add this to the 
previous curve.  Repeat twice again, making four curves in all. 
Your layout should now look like that at left.  You should have four curves forming a 
half-circle joined to the thru track end of the turnout.  Now we are going to add the 
second turnout in order to complete the spur siding.  Before we can do this, we have 
to make room for it by removing a curved track from the inside loop. 

 Put the mouse pointer over the O-31 curve on the upper right of the oval, where the 
turnout will be going (this should be obvious since all our track is converging here).  Single-click the left mouse 
button to highlight this curve, and then delete it from the layout by either pressing the DELETE key on the 
keyboard, or by pulling down the Edit menu and choosing Delete, or by pressing the right mouse button to pop 
up a shortcut menu and choosing Delete.  When you delete this curve, you are left with three dangling track 
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ends perfectly positioned for an O-31 right-
hand turnout.  Pull down the Track menu 
and select O-turnouts -> O-31(modern) 
45° R and place this such that it joins to all 
three dangling ends ( RR-Track will go 
through two automatic joinings for the 
other two ends of the turnout).  At this 
point, your layout should now look like:

You have 20 pieces of track: 8 straight 
sections, 10 curved sections (actually 11 
with the one we left in the middle), and two 
turnouts.  You can check this if you like by 
clicking on the Component View tab. 
Next we are going to break this extended oval into two parts and widen it. 

Expanding the Loop

We are going to expand the loop vertically by breaking it in 
two sections and inserting filler straight sections as needed. 
First, we have to select all of the track in the upper half of 
the loop.  We could do this by going down each piece, one 
by one, and clicking them with the left mouse button while 
holding the SHIFT key.  Instead, we will use a selection box; 
that is we will sweep out a rectangular area on the screen that contains all of the items we want to select.  Move 
the mouse pointer so that it is above at the left of the loop, then, while holding down the left mouse button, drag 
out a selection box that includes track in the upper half of the oval (see the figure at right for a guide as to how 
this should look).

Make sure that the track in the upper half of the loop is completely in the selection box, only items completely 
inside will be selected.  When you have completed the selection box, release the left mouse button.  All of the 
track in the upper half of the oval should be selected.  If this is not the case, single-click in a blank area to 
deselect the selected items and try again.

When you have all of the track in the upper 
half of the loop highlighted, place the mouse 
pointer on one of the sections, depress and 
hold down the left mouse button until the 

 cursor appears, and then drag the 

highlighted track upwards far enough so that 
when you release the left mouse button the 
layout will split into two halves like that at 
right.

The next step is to put in some filler straight 
sections, in this case two in each leg except 
the rightmost ( here we are going to do 
something different).  Pull down the Track 
menu and choose O-straight -> Lionel 
single, and join this track section to the far 
left free track end on the lower oval half, 
select another straight track section and join 
this to the center free track end, then repeat this process and add another straight section to each of the left and 
center free ends.  This adds two track sections each to the left and center spurs, and nothing to the rightmost 
spur.  

Now we want to put the oval back together by rejoining the top half (which we recently removed) to the bottom 
section which we have just extended by adding the three straight track sections.
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Place the mouse pointer on one of the track sections in 
the upper loop and double-click the left mouse button so 
that all of the track sections in the upper half highlight 
and hold the button down.  When the cursor changes to 

 drag the half loop 

down close enough so 
that RR-Track can join up 
the left and middle spurs. 
You layout should look like 
that at left. This leaves us 
with a gap of 20 inches on 
the passing siding.  We 
could fill this with two 

straight sections, but we won't do that.  Instead we will change the curves on the 
passing siding to O-42 and fill the gap with a custom straight section of track, just 
to get in some more practice in modifying existing track arrangements and in 
using RR-Track’s measuring tools.

With the mouse pointer, select (highlight) the four O-31 curves on the passing 
siding and delete them (you can use the DELETE key for this).  Next, pull down 
the Track menu and choose O-curve -> O-42 30° L.  Join this new curve to the 
free end on the lower turnout.  Add five more O-42 curves (it takes six for a 
semicircle rather than the four for the O-31 curves since each O-42 curve is a 30° 
arc rather than a 45° arc) placing a total of three of them on the upper spur and three on the lower.  Your layout 
should look like that at right.  

This leaves us with a gap, which, as we shall shortly discover, is too short of fill in with a regular straight section, 
and too long to fill in with a half section (unless you want to resort to serious bending and warping of the track 
junctions of the O-42 curves.  Instead we are going to make use of the measuring capabilities of RR-Track, and 
the TrackWizard in the O-gauge track library, to automatically cut a fitter straight section and place it in the gap.

Measuring the Gap

Now we need to find out how big a gap we have.  We can snap a measurement between the track ends on 
either side of the gap by

• Right click over nothing bringing up the general purpose shortcut menu. 

• Choose Measure Track.  The cursor changes to the ruler cursor .  If you 

want distances resolved in the track end coordinate system, choose Measure 
Trk-Crd instead.  In this case the cursor will change to . 

• Place the ruler hotspot where you want start the measurement and depress 
and hold the left-mouse button. 

• While holding the left-mouse button down, drag the ruler hotspot to where you 
want to terminate the measurement.  RR-Track draws a line showing the 
distance measured. 

• Release the left-mouse button.  RR-Track displays the measurement results in the upper right corner of 
the layout window. 

RR-Track displays the measurement results which look like that at right.  This dialog shows the horizontal and 
vertical components of the distance measurement, as well as the total distance and the angle (in this case the 
distance is 7.85 inches and the angle is 90°).  There is a Done button, to dismiss the Distance Measurement  
dialog without carrying out any further functions, and three buttons (there may be more depending on the track 
library) for engaging the TrackWizard.  
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Here we want to automatically fill in the the gap so press the <stock 
track> button.  This send the results of the measurement we just made 
to the TrackWizard, which examines the track ends and their orientation, 
and creates fitter track section(s) as needed and if possible, in order to 
fill the gap.  In this case it is simple, cut a 7.85 inch piece of straight track 
and place it in the gap.  

After pressing the <stock track> button the Distance Measurement 
dialog vanishes and your layout should now look like that at right.

You have now constructed a simple loop of track, added a spur passing 
siding, and then expanded the layout vertically in order to create more 
space for the trains to run in.  In the next part of this tutorial we will add a 
grade and an elevated loop of track.  Before we do that, just for fun, click 
on the 3D-VIew tab.  You should get a 3D View of your layout that looks 
something like that below:

You are now ready for the next part of the basic track laying tutorial where we start elevating track and adding in 
grades. 
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Getting Started Part 3– Elevations and Grades
In this, the third part of the RR-Track Tutorial, we are going to introduce elevated track and grades. 

Elevating Track

We will start the process of putting in a grade by elevating some track, and then designating other track as 
grades to link the elevated track with the rest of the layout.  Move over to the left 
side of the layout and highlight both of the vertical straight 
track sections.  You can do this by left clicking on the first 
track section, then holding down the SHIFT key and left-
clicking on the second track section (holding down the 
SHIFT key tells RR-Track to add the next selection to the 
current selections, see selecting items for more 
information). 

Next, pull down the Grades menu and choose Set Track 
Height.  This command gives you the Set Track Height dialog, like that at left.

Here you have an edit control which has the absolute height above the layout base you 
want to place the track, up/down spin buttons from changing this height in fixed 
increments which you can choose from in the radio buttons below, and a check box for 
creating an overpass track. You can either use the spin buttons to move the number in 
the edit control to 6.00 inches, or you can select all the text in the control and type in 6 
and then press OK.  RR-Track immediately sets the height of the selected track to 6.00 
inches.  Your layout should look like that at right.  Note that the track sections you have 
just elevated have their heights shown (all non-zero heights are shown if Show Grade 
Heights is checked in the Layout Options dialog, we did this back at the first).

Now we have to set the grade on 
each side of the elevated track sections.  It is a good idea to 
leave switches level on the layout, although we don't have 
to, but for the moment we will.  First we set the upper grade.  
Move to the upper left of the oval and select all of the track 
the elevated sections to the turnout (both O-31 curves and 
four straight sections).  You can either use the SHIFT-key 
left-click method or drag out a selection box around these six 
track sections until they are all highlighted as shown at left.

Now that you have these six sections highlighted, pull down the Grades menu and choose 
Create Grade. RR-Track smoothly interpolates all of the intermediate heights of the track 
sections that are required to take the elevation from a height of 0.00 at the turnout to a height 
of 6.00 inches at the two straight sections.  RR-Track then displays a dialog that shows you 
the fundamental information about the grade you just created.  This is shown at the left.  
Here we see we have a total length of 
62.46 inches, and an elevation change of 
6.0 inches which gives a grade of 9.6 per 
cent which is pretty steep, more steep than 

even a Lionel trestle set (this is actually too steep for even a 
toy train layout).  For the moment we will live with this grade 
and press the Done button.  They only way to decrease the 
grade is to either add more track sections to the grade, or to 
decrease the height of the elevated track.

Now that we have set a grade, the upper left portion of the oval should have a series of steadily increasing track 
heights, like that shown at right.  Note that the heights smoothly increase as you go from the turnout to the 
elevated track.  These are the heights at the center of the track section;  you can also tell RR-Track to give you 
the height at the upper end;  the upper end height is useful for cutting risers for the track sections.  You can also 
get the height of a track section by calling up the Item Properties dialog.  This is done by move the mouse 
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pointer over the track section you want and clicking the right mouse button.  
This brings up a shortcut menu.  Scroll down this menu and choose 
Properties...  When you do, you get a dialog like that at left.  Here we have 
a section of Lionel O track with a horizontal location of 47.82 inches, a 
vertical location of 73.50 inches, and a height of 2.40 inches.  It is rotated 
180° and has a length of 10 inches.  It is also located in the track 1 layer 
since we never changed the drawing layer at the start of this tutorial.  Press 
the OK button when you are done with the properties dialog.

 

Enough of this grade and 
parameter discussion, 

let’s take a look at this from a three-dimensional perspective.  
Click on the 3D-View tab and, after doing a little rotating with 
the sliders, you should have something like that at right ( if 
you can’t get the sliders to rotate to an orientation you like, 
take a look at 3D-View operations ).

As you can see, we still have to do something with the track 
on the other side of the two elevated sections.  Repeat the 
process we carried out on the upper grade track:  choose all 
of the six of the track sections from the elevated track to the 
turnout, pull down the Grades menu and choose Create Grade.  This will create an identical grade on the lower 
side of the oval.  Your layout ( in Plan View ) should look like that below. 

As we mentioned before, a 9.6 per cent grade is much 
too steep for even toy trains to traverse ( real trains 
aren’t happy with 1 per cent grades ).  To decrease the 
grade we can either decrease the height difference 
between the track on each end of the grade, or lengthen 
the grade.  Lets try decreasing the height difference 
since lengthening the grade means expanding the 
layout again.

Modifying the Grade

We are going to decrease the height difference not by 
lowering the track at the raised end, but rather by 
raising the track at the lower end.  Using the mouse 

pointer, select the two turnouts and the four track sections in between the spur tracks.  Then pull down the 
Grades menu and choose Set Track Height.  When the Set Track Height dialog appears, set a height of 2.00 
inches and press OK.   Notice that RR-Track has raised up all six sections to 2 inches, and automatically 
recalculated the grades we previously put in.  We can find out how steep the grades are now if we use the 
Grade Information command.  To use this we first have to select a grade.  At the moment, the extended 
selecting mode ( you remember that don't you) set to Selections Include Joints.  This means that when you 
double-click with the left mouse button on a track section, RR-Track selects that track section and all of the 
others that are physically joined to it.  We want to change this so that we choose all of the track on a grade or a 
given height instead.  We do this by pulling down the Options menu and checking Selections Include Grades.  
Now when we double-click on an item, RR-Track chooses that track section and all of the physically connected 
sections that are at the same height or on the same grade.

Note:  when the extended selection mode is set for grade track, you can get quite a bit of grade 
information just by hovering the cursor over the grade / elevated track. If you hover the cursor over a 
single elevated track section the hint window will show the height as well as the item description and 
layer.  If you double-click so that all of the grade track is highlighted, then hovering the cursor over any 
one section will show the grade length, the rise, and the grade per cent rather than the description of that 
track section.

By either pulling down the Grades menu and choosing Grade Information or by hovering the pointer over the 
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selected grade, we can find out the new grade parameters, namely a rise of 4.0 inches ( 6 - 2 ) and a per cent 
grade of 6.4.  Just to see how this exercise in elevating track is coming, click on the 3D-View tab, you should 
see something like that below.  Now the only track still flat on the table is the O42 spur loop. 

 
To finish this off, we need to set the final grades on the O-42 
passing siding.  We will leave the straight track in the middle at 
table level, and choose the curves on each side as grade 
track.  To set the first grade, choose all three O-42 curves on 
the lower right side of the oval; then pull down the Grades 
menu and choose Create Grade.  This will give you a grade 
with a height change of 2.0 inches and a grade of 6.2 per 
cent.  Repeat this for the three curves on the upper right, 
again creating a 6.2 per cent grade.  You now have a layout 

that slopes down from left to right, in a fairly smooth manner.  If you like, you can take a look at this in 3D by 
clicking on the 3D-View tab, as always.

 
Next we want to add a second loop of track, that 
is elevated above the track we already have on 
the layout.  The best way to do this is to put this 
track in another layer, making future 
manipulations for the two track loops easier and 
cleaner.

Using Multiple Layers

To see that layers we currently have, pull down 
the Options menu and choose Layers...  RR-
Track shows the Layer Setup dialog, like that 
below:

Here we see we have 12 layers already set up in our layout.  The working layer, the one we add things to, is 
shown in red, any active layers are shown in green, inactive 
layers are shown in blue, grayed and hidden layers in gray.  
At the moment we are using the track 1 layer (it is in red).  
The important thing to remember concerning the Layer 
Setup dialog is that you use this dialog to add layers, remove 
layers, rename layers, change layer default colors, and 
change layer visibility.  Press the OK button.

We want to put the new loop of track into another layer, say 
the track 2 layer.  We could go back to the Layer Setup 
dialog and make the track 2 layer the working layer ( the 
one we add things to ), but there is a faster method.  Move 
the mouse pointer down to the status bar, over the area 

showing  .  This is the layers access point on the status bar.  Move the cursor over the arrowhead symbol until it 
changes to  , then click the left mouse button.  RR-Track pops 

up a list of all the layers in the layout, colored in the same manner used in the Layer Setup dialog, with the 
current working layer selected.  Move the mouse pointer over the 'track 2' layer and click the left mouse button.  
RR-Track makes the 'track 2' layer the working layer, and makes the 'track 1' layer inactive.   For more 
information on these kind of shortcuts see using the status bar.  Now that we have made the 'track 2' layer 
working, we are ready to start a new loop.  Note that if you hover the pointer over the track sections in the track 
1 layer, you still get the hint information but the cursor is ‘grayed’ indicating that you cannot select this item.

Adding an Elevated Loop

Next we want to create an upper level track loop.  Get a single 10 inch Lionel straight track by your method of 
choice (Track menu or status bar Last Track List --- you can pop this up just like you did the layer list; RR-Track 
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remembers the last 10 distinct track sections used).  Then, before you place it in the layout, press the ESC key 
on the keyboard.  This turns off automatic track joining for this piece; 
the cursor changes to   to let you know joining will not 

occur.  Place the track section as shown at left.  Next, pull down the 
Grades menu and choose Set Track Height (the track section 
should be highlighted as a result of placing it; if it is not for some 
reason, single-click on it with the left mouse button).  You can also 

choose Change Height from the Action menu as well  Set the height to 7.5 inches and then press OK.

Now get three additional straight track sections and one O-31 
curve and attach them as shown below in the figure.

We want to set up a loop of upper level track that crosses above 
the lower level track.  To make things a little easier to see clearly, 
we will gray out the 'track 1' layer (this is the lower level track).  
We can do this by pulling down the Options menu and choosing 
Layers... which gives us the Layer setup dialog, or we can do it 
quickly from the status bar.  To gray the 'track 1' layer from the 
status bar, go down the the layer name and bring up the layer list 
like we did before.  This time, instead of left-clicking on the layer, we will right click with the mouse.  Move the 
mouse pointer over the 'track 1' layer and click the right mouse button.  This pops up a shortcut menu like that at 
left.

Here you have choices as to how to set the layer attributes:  active, inactive, 
grayed, and hidden.  Click on grayed;  RR-Track immediately grays out the 
'track 1' layer.  Now the upper level layer stands out, but the lower level track is 
still visible and easy to register.  You will find it convenient to either gray or hide 
items in other layers while your work on details in the layer of interest.  Another 
useful feature when you are working between a pair of layers is the Last Layer 
command from the shortcut menu you get when right-clicking over nothing.  
This will make the previous layer you were using the working layer, while 
making the current layer inactive.  Using the Last Layer command a second 
time gets you back to your starting layer configuration ( very similar to using the 
Zoom Last command when going back and forth between views). 

Now add six more O-31 curves and two more 10 inch straight 
sections until you get something that looks like that at left. 

Here we are forming a triangle shaped loop of track that partly 
overlaps the lower level.  Now lets use the TrackWizard to fill in 
the gap.  To do so, we have to snap a measurement between 
track junctions (if you recall, we did this in part 2 of the tutorial).  
Right-click over nothing and choose Measure track from the 
shortcut menu.  Then proceed as before and snap a 
measurement line between the two exposed track ends of the 
upper loop ( if you have forgotten how to do this, go back to the 
previous chapter or take a look at the essay on making 
measurements ).  When the TrackWizard brings up the Distance 
Measurement dialog, choose <stock track> and the gap will be 

automatically filled in a fashion like that below. 
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TrackWizard always tries to use the largest radius curve 
available that will fit in a gap; in this case O-72 was the largest 
curve available in the Lionel O track library.  To see what all of 
this looks like in 3D, we have to ungray the 'track 1' layer or it 
will be invisible in 3D-View, unless we tell 3D-View specifically 
to do so.  Go down to the status bar and pop up the layer list, 
move the pointer to the 'track 1' layer and pop up the shortcut 
menu by right-clicking.  Choose Inactive from the choices 
there; RR-Track redraws the layout with the lower level a 
normal color.  Now click the 3D-View tab and you should get 
something like that below.  

 
This is interesting.  Notice that 3D-View has both built up 
terrain underneath the elevated track ( without you specifying this ), but has also cut passages ( tunnels? ) so 

that the lower level track can go through.  

This is the default behavior, unless track is directly 
flagged as tunnel track or overpass track, 3D-View 
cuts away and builds up terrain so that the track has 
clearance. 

We can make the overpass areas a bit more obvious 
by designating some of the upper level track as 
overpass track.  This means that terrain will not be 
build up beneath it ( tunnel track designation lets 
terrain overflow the track instead of being cut away).

Designating Overpass Track

Designating overpass track sections is easy to do.  
First, move the mouse pointer over four of the 10 inch straight sections and highlight them (remember to use the 
SHIFT key to allow you to individually highlight items).   You should 
highlight the track sections as shown at right.  

Next, with the mouse pointer over one of the highlighted track 
sections, click the right mouse button to bring up the  shortcut menu.  
From this menu choose Toggle Overpass.  RR-Track applies the 
overpass property to all four of the selected track sections.  To find out 
how this looks, switch back to 3D-View by clicking the 3D-VIew tab. 

Notice that the openings for the lower level track extend the full length 
of the track sections that were designated overpass.

This ends the third part of the tutorial.  You have 
learned how to create and modify grades, and elevate 
track.  You have also learned the use of the 
TrackWizard for filling in gaps and closing loops.  In the 
next part of the tutorial we will look into adding some 
scenery and terrain features.
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Getting Started Part 4:  Scenery, Buildings, and General Purpose Objects
In this chapter of the RR-Track Tutorial, we are going to add some scenery and other objects to the layout we 
have been working on.

After finishing the second part of the tutorial, we have a layout that looks like 
that at left.  Now we need to jazz this up by adding some other objects to the 
layout.  Before we add any thing, we want to change the working layer to the 
'buildings' layer.  If you remember how we did this, we went down to the 
status bar and popped up the layer list, then chose the layer we wanted to 
use as the working layer.  Do this by moving the pointer to the status bar and 
choosing the 'buildings' layer.

Now that we are in the buildings layer, pull down the Objects menu and 
choose Buildings and then Truss bridge.  The cursor changes to  letting you know that you are about to 

denote the starting point (origin) of the truss bridge.  Before you draw in the bridge, take a moment to change the 
snap size to 0.5 inches to make it a bit easier to draw a 5 by 32 inch bridge.  Now, move the cursor to the three 
track sections in the upper level that cross over the lower track loop and siding.

Move the cursor to the starting point (one of the corners of the bridge, it doesn't matter which one you use, we 
happen to use the upper left).  Depress and hold the left mouse button;  the cursor changes to    so that 

you know you are supposed to sweep out a rectangle.  While continuing to hold down the left mouse button, 
move the pointer so that you begin to sweep out a rectangle that is the width and length you require for the 
railroad bridge (we want to make a rectangle that is 32 inches long and 5 inches wide).  As you move the pointer, 
RR-Track draws a trial rectangle defined by your starting point and the current pointer position.  RR-Track also 
displays a pop up window (at the upper right corner of the layout window) that shows the size as you are 
dragging the pointer.

Move the pointer until you get a rectangle 32 by 5 inches, with the 
long dimension horizontal.  The layout should look like that at left.  
RR-Track compares the length and width of the bridge, then sizes 
and spaces the trusses accordingly.  The only problem we have 
now is that the bridge is at zero height.  To remedy this, we have to 
set a new height.  Recall that we set the upper level track loop at 

7.5 inches;  we will set the bridge at or slightly below this height so the track appears to pass over the bridge.  
Select the bridge object and then pull down the Action menu and choose Change Height ( you can also right-
click on the bridge and choose Change Height).  When you get the dialog for setting the height, set it to 7.5 
inches (7.4 or 7.3 will also do).  This should be available as the 
last height as well.  Then press Set Height to lock in the new 
height.  Now we take a look at a 3D view of the layout.  In 3D, the 
bridge should look like that at left.

The default bridge color is light gray; you can change this to 
whatever you want by right clicking on the bridge and then 
choosing Properties from the shortcut menu.  The Object 
Properties Inspector lets you change any or all of the object 
properties, including the color (you can also change the size and 
height by typing in new values if you want).   Now, go ahead and 
draw in a 5 by 12 inch girder bridge.  Here you will have to create 
the bridge, then rotate it by 90° and raise it up to 7.5 inches height (the reason you have to rotate the bridge is 
that RR-Track assumes the horizontal  direction is along the track for bridges, while the vertical dimensions 
defines the width --- otherwise you would not be able to create a short and wide bridge).  Repeat the above 
steps, only this time keep the horizontal length to 12 inches.  In order to rotate the bridge by 90° to align it with 
the track, you can choose one of three methods:  (1) manual rotation where you select the bridge, pull down the 
Action menu and choose Rotate, (2) quick rotation where you right click on the bridge and choose Rotate from 
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the shortcut menu, or (3) keyboard rotation where you select the bridge and then use the up and down arrow 
keys to rotate the bridge incrementally until you get the orientation you want.  We are going to use the third 

method. 

Select the bridge, then hold down the CONTROL key and press the up arrow 
key on the keyboard.  You should see the bridge rotate by a small amount CCW, 
like that at left.  Press the up arrow key again; the bridge rotates a little further.  
Keep hitting the up arrow key until the bridge is straight up.  After you have set 
the bridge height to 7.5 inches, and made sure you have it positioned correctly 
for carry the 10 inch straight section over the lower track, click on the 3D-View 
tab to see what it looks like.

You can add any number of other objects to represent whatever structures 
you have/need on your layout.  

As an exercise, we will add a six-sided polygon, and then extrude it to 
represent a solid object.  Verify that you are still in the buildings layer, then 
pull down the Objects menu and choose Filled Polygon.  from the Basic 
Shapes submenu.  The cursor changes to     indicating you are to 

designate the initial vertex (origin) of the polygon.  Move the pointer to 
where you want to set the first point (in the bullseye), and then click the left 
mouse button (don't hold it down).  RR-Track sets the initial vertex at this location, then changes the cursor to  

   so you know you are still in polygon creation mode and a left mouse click designates the next vertex.  

Move to the next position and click the left mouse button.  RR-Track draws the polygon segments out as you 
designate each new point.  As soon as you have set two points and are moving to the third, RR-Track shows 
where the return line will be if the next point is the last point ( you must have at least three points to have a 
polygon ).  When you get to the sixth point, double-click the left mouse button, or right-click --- either one  tells 
RR-Track that this point is the last point.  RR-Track closes the polygon and then changes the pointer to the 

standard arrow.  When you finish the six sided polygon, you should have something that 
looks like that at left.

We placed the hexagon in the lower left corner, but anywhere will do for this tutorial; if 
you don’t like where you placed it, just move it to a new location ( see moving items if 
you need a reminder on how to do this).  Now let's give it some depth.  Select the 
hexagon you just created, pull down the Action menu and choose Extrude ( or right-
click on the hexagon and choose Extrude ).  When you do so, you will see the Object 
Extrusion dialog.  Either by using the up/down spinners or typing in the number, set the 

extrusion depth to 5.0 inches.   When you click on 3D-View, your extrude hexagon 
should look like this.

Gray is the normal default color for RR-Track general purpose objects.  To change 
the extruded hexagon's color, right click on it and choose Properties...  This brings 
up the Object Properties Inspector.  Press on the Color and Style tab to reach the 
page where you can view and set the draw and fill colors.  Using the drop-down 
selection list, choose a new fill color, such as brown.  Then press the Close button at the bottom of the Object  
Properties Inspector to dismiss it.  You will now have a brown colored hexagon.

Grouping Objects

To make something more complex, we need to practice grouping objects.  This lets you make a complicated 
object out of several, and then manipulate them as a collective entity ( like creating modules out of track and 
other items, but more simple ).  We will start by making something you see on lots of railroads, a trackside tank 
platform.

First, select the hexagon we just made and delete it by pressing the Delete key.  
Now, draw in a filled rectangle 18.0 inches long and 6 inches wide by pulling down 
the Object menu and choosing Filled Rectangle from the Basic Shapes submenu 
(you designate a rectangle just like you did the railroad bridges earlier, using a left 
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mouse down - drag - release mouse button sequence).  Next select it and extrude it 1.0 inch and then change 
the color to some sort of light tan (or whatever you want).  You should have something that looks like that at left.

Next we are going to draw an oil tank.  Pull down the Objects menu and choose Filled Circle from the Basic 
Shapes submenu.  The cursor changes to    .  Position the mouse pointer somewhere near the platform 

you just made and depress and hold down the left mouse button.  The cursor changes to   indicating you 

are to drag out the radius of the circle (we will want 2.5 inches).  While holding down the left mouse button, drag 
the pointer to the right.  RR-Track draws a circle of increasing diameter as you move the pointer;  when you 
reach 2.5 inches radius (as shown in the pop up information window) release the left mouse button.  RR-Track 
draws a 2.5 inch radius, 5.0 inch diameter circle.

Now we have to both extrude it and raise it up to the platform height.  Select the circle 
and extrude it 5 inches by pulling down the Action menu and choosing Extrude.  You 
should now have something that looks like that at left.

Now we have to place the tank on the platform, and raise it up to platform level, 1.0 inch.  
Move the tank, using either the mouse pointer or the keyboard so that it is centered on 
the left end of the platform.  Next, raise the tank up by (1) selecting it, and then (2) pulling 
down the Action menu and choosing Change Height (or right-clicking and choosing 
Change Height ), then setting 1.0 inch in the edit box and pressing the Set Height button 

(you can also call up the Object Property Inspector by right clicking on the tank and then choosing Properties... 
You can then type in the height directly).  Now get another identical tank by right 
clicking on the tank and choosing Duplicate from the shortcut menu.  Place this new 
tank adjacent to the first one.  When you are done with this you should have 
something that looks like the figure at right.

Now we are going to place a control shed on the right end of the platform.  Pull down 
the Objects menu and choosing Simple Building from the Buildings submenu.  This 
is designated like a rectangle (like we did the bridge and the platform).  Drag out the 
pointer to make a building 3.5 inches wide and 4.0 inches in depth, then place it next to 
the two tanks like that at left.  Make sure you have set the height of the control shed to 
1.0 inch to put it on top of the platform, otherwise it will by drawn sticking through the 

platform.

Now, draw a cross-connection structure at the top by dragging a filled rectangle out to 6 inches long and 1 inch 
deep, change the color to dark gray, and place it across the two tanks like so (you will have to change the snap 
size to 0.25 inches in order to center it as shown).  Make sure you set the height to 5.5 
inches ( or 6 inches if you want it completely on top).  You can change any of the 
individual colors if you want.  

To group the five separate objects into one object, drag a selection 
rectangle around all of the, so they  are all highlighted. Then pull down the Action menu 
and choose Group Objects.  RR-Track compiles all of the objects into one so that now if 
you click on any part of the group, all items highlight.  You can copy, paste, duplicate the 
entire group as if it were one object.  To modify the group, you first have to ungroup it, 
make your changes, then regroup the objects.

Scenery

Now lets add a few trees.  First, change the working layer to the Scenery layer (either use the Layer  Setup 
dialog or the status bar for this).  Pull down the Objects menu and choose Spring Tree from the Scenery 
submenu.  As usual, the cursor changes to    indicating you are going to designate the origin of a new 

object.  Move the pointer to where you want the tree and depress and hold down the left mouse button.  The 
cursor changes to    to let you know you have to set the object size by dragging out a radius (just like you 

did for the filled circles in the platform).  While holding down the left mouse button, drag the radius out to 2 
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inches (this will give a large 4 inch diameter tree).  When you reach the 2 inch radius, release the mouse button.  
RR-Track draws the tree, looking something like that at left.  RR-Track randomizes the 
edges (trees are considered polygons), and blends the colors.  Now repeat the above 
process, drawing several more trees.  You can go up to the Objects menu to choose the 
tree again, or you can press the SPACEBAR to get a new object instance (this is the same 
as choosing from the menu and is the object equivalent of double-clicking over nothing for 
getting a new instance of track).  In any event, after a few trees you should have something 
like the 3D-View at right.

Go ahead an draw in a few other trees, and other tree varieties if you like.  
You can manually set the colors of trees by going to the Object Properties 
Inspector, just as you would for any other object.

This ends the fourth part of the tutorial  In the next section we are going to 
see how to add terrain features and bench units to the layout.
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Getting Started Part 5:  Benchwork and Terrain
In the fifth part of the RR-Track Tutorial, we are going to play with creating layout bench units and adding terrain 
features to the layout design.  So far, we have worked on a one-table layout;  we have a solid 10ft x 7ft 
rectangular bench.  Most real layouts are not like that, and some are quite complex in their bench configuration 
and arrangement.

In order to successfully create a layout with an irregular shape, you must create and place layout bench units  All 
RR-Track layouts start out as rectangular, regardless of the actual shape of the real layout.  In this rectangular 
area ( sandbox if you will ) you place layout bench units which are exactly analogous to benches you build to 
support your layout.  For instance, an L-shaped layout would have a rectangular shape that encompasses the L, 
with at least two rectangle base units forming the arms of the L.  When you use the RR-Track New Layout 
Wizard to start a new layout, standard shapes include L-shaped, C-shaped, and perimeter layouts which 
automatically place required rectangular bench units accordingly.

To create new layout bench units you have to switch to Terrain View.  This is done by clicking on the Terrain 
View tab, just as you would for Plan View or Component View.  A Terrain View of our layout is below.

Terrain View shows an overview of your 
layout, with track and terrain indicated.  
Track is drawn with bold, brown centerlines 
( dashes for overpasses ).  You also have a 
window that shows a data sheet of all 
terrain base and contour items ( there is 
one at present ).  At the moment we have 
Terrain View set to not show the cross-
section view; this can be enabled using the 
Terrain View Options dialog. 

We are going to modify the one base on 
the existing layout and then add additional 
base units to create a non-rectangular 
layout.  What we end up with is not 
necessarily something you may choose to 
actually build, but it will illustrate how you 
can combine bench units to get the shapes 
you need.

There are five types of bench units 
available in RR-Track:  (1) rectangles ( the most common on any type of layout ), (2) triangles, (3) semi-circles, 
(4) quarter-circles, and (5) polygons.  Triangles, semi- and quarter-circles are really special cases of polygons.  
Triangles are polygons limited to three points ( duh! ), while semi- and quarter-circles are polygons with many 
points that you designate in the manner of a circle ( like a tree object ) but are slices of the circle limited to 180° 
and 90° respectively. 

The first step is to resize the one rectangular bench unit we already have to make space on either side of other 
shapes.  Start by setting the snap size to 12 inches to make it easier to resize on 1ft boundaries.  This can be 
done either by (1) pulling down the Options menu and choosing Terrain Options and setting the snap size 
using the Terrain Options dialog, or (2) by going to the status bar, popping up the list of Terrain View snap 
sizes, and choosing 12 inches ( see Terrain View status bar for further information ). 

Quick Tips:

To Resize the Rectangular Bench Unit

• click on it with the left mouse button to select it.  It will highlight in a red cross-hatch  when selected. 
• Move the pointer over one of the left side edit handles ( either bottom or top corner ), the cursor changes 

to  when you are there. 
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• Depress and hold the left mouse button and drag the corner rightward two feet.  Release the left mouse 
button when you have done this. 

• Go to the right hand side edit handles and do the same thing as you did to the left side, moving it 
leftward two feet.  Release the left mouse button when you have done this. 

You should have something that looks like that below at 
this point.  Now there is room on each side to make the 
layout shape more interesting.  First, we will add a small 
filler rectangular base unit to the left side, then cap this 
with top and bottom quarter circles.  

Go down to the Terrain View status bar to the New Base 
button, place the cursor over the up arrow and press the 
left mouse button to bring up the 
layout base list, like that at left  
You need to move the pointer up 
and choose rectangle.  Placing 
a rectangular base is the same 
as placing any other rectangle 
object .  

To Make a Rectangular Base

• Choose the rectangle from the New Base list. As you move the pointer over your the Terrain Overview, 
the cursor changes to . 

• Move the pointer to the spot where you wish to position the first corner (it does not matter which one).  
Depress and hold down the left mouse button; the cursor changes to   . 

• While continuing to hold the left mouse button down, drag the pointer to the opposite 
corner.  RR-Track draws the outline of the rectangle as you move the pointer 
providing visual cues to the size and position of the rectangular object. 

• When you are satisfied with the size and shape of the rectangular object, release the 
left mouse button.  RR-Track immediately draws the object, changing the cursor to  
the standard arrow. 

.You should end up with something like that at right.   If you don’t end up with the rectangular 
base exactly at this point, just grab it with the pointer and move it to where it is needed, just 
as you would any other object ( see moving items ).  

Now we want to fill in the lower cut out with a 2ft radius quarter circle.  To do this, navigate to the status bar, pop 
up the New Base list and choose 1/4 circle from the choices.  Designating the quarter-circle is like drawing a 
tree or any other circle-derived object, you start by designating the center point and then dragging out to the 
appropriate radius and angle.  

To Make a Quarter Circle

• Choose the 1/4-circle from the New Base list.  As you move the pointer over the 
Terrain Overview, the cursor changes to   . 

• Place the pointer hotspot at the location you want the center point of the quarter-
circle.  Press and hold the left mouse button.  This both designates the center, and 
changes the cursor to   indicating you are now supposed to designate the 

radius. 
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• While holding down the left mouse button, drag the pointer out to the desired radius (RR-Track displays 
a small window at the upper right of the Terrain Overview showing the current radius).  The current circle 
is drawn and redrawn as you change the radius. 

• When you reach the desired radius and orientation ( you may have to move the cursor around some to 
get the correct orientation), release the left mouse button.  RR-Track immediately draws the quarter-
circle and returns the pointer to the standard arrow. 

When dragging out a quarter or semi-circle, the line from the designated center to the cursor forms one of the 
terminating edges.  As you move the end point around in an arc, RR-Track outlines where the quarter or semi-
circle will be.  You can read more about creating and designating base units in the how to topic on general 

purpose objects.

You should have something like that above right.  

We want to finish off this end of the layout base units by placing another quarter-circle filling 
much of the upper cutout, but a little smaller ( 18 inch radius ).  To make this work you need 
to reset the snap size to 6 inches ( something less than 12 inches ).  When you are done, you 
want to have something that looks like that at left.  You would probably never build something 
like this, but this does demonstrate the kind of shapes and configurations that may be 
achieved.

Now we have to go work on the other end.  Here we will use a combination of triangles and 
polygons to create a non-simple boundary.  For the upper right we want to fill this are using a 
quadrilateral ( four point polygon ).  To do this we have to choose a polygon base unit from 
the New Base list and then start designating vertex points.  Leaving the Terrain View snap 
size at 6 inches carry out the following instructions:

To Make a Polygon Base

• Choose the  polygon base from the New Base list on the Terrain View status bar.  As you move the 
pointer across the Terrain Overview, the cursor changes to   , indicating RR-Track 

awaits your designation of the first polygon vertex. 

• When you have the pointer at the desired initial vertex point, click the left mouse button.  
The cursor changes to   indicating RR-Track is now ready for the next vertex. 

• Move the pointer to the desired position of the next polygon vertex and click the left 
mouse button.  Repeat this step until you have designated all of the points save the last 
one.  Once you have designated the first two points, RR-Track shows you the projected 
return line. 

• When you reach the last vertex, double-click the left mouse button or single-click the right mouse 
button.  This tells RR-Track that this is the last vertex.  RR-Track closes the polygon, draws it, and 
returns the cursor to the standard arrow. 

When you are finished, you want a polygon base that looks like that at right.  The next move is to fill in the 
bottom with a triangle base unit ( this is a polygon limited to three sides -- it is a special case in Terrain View 
because these are used a lot for fillers on inside corners, etc.).  You designate a triangle base in exactly the 
same you did the polygon base unit above, except that RR-Track automatically terminates the polygon at the 
third point, i.e. you will not have to double-click or right-click to tell RR-Track to close the triangle.  When you 
finish with the triangle, you should have a Terrain View of your benches that look like that at left.  Unlike the left 
side of this demo layout we finished the right side with some angular, blocky bench units.  

If you take a look at the results in 3D-View, you should have something resembling that below. 
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Not mainstream, but it demonstrates making an odd-shaped layout. 
Adding Contour Objects

Now that we have set the layout bases/benches, we need to put in some vertical terrain.  RR-Track has three 
contour objects for defining vertical terrain.  These are

• (1) Contour points, 

• (2) Open contour lines 

• (3) Closed contour lines.  

Contour points are just that, individual points.  Contour lines are like a polyline; a collection of individual points at 
the same height.  A closed contour is like a polygon in that all of the contour points are at the height, and a line 
connects the last point to the first.  In all cases heights are keyed on the individual contour points.

You can get a new contour object of any type by either pulling down the Action menu and choosing the new 
contour object of your choice, or by navigating to the status bar to the New Contour button.  You press the 
button to get another contour object like that named, or press the up arrow to get a list of all available contour 
objects.

For starters, we are going to add a single contour point.  Before we begin, we are going to set 
the current contour height by using the Contour Height button the the status bar.  

• Press the Contour Height button which brings up the Contour Height dialog like that 
at right.  Use the up down spinner or type in a height of 18 inches and press Set 
Height.  

• Next go over to the New Contour button.  If it is not reading ‘Point’, hover over the 
up arrow and press it to bring up the Contour Objects list.  Choose Point from the list. 

• The cursor moves to the center of the Terrain View overview window and the cursor changes to   

indicating you need to designate the contour object’s first ( and in this case only ) point. 
• Move the cursor to somewhere in the space near the 

center of the layout where the upper and lower level tracks 
form a rectangular space, and click the left mouse button.  
Terrain View places a small yellow circle at the location of 
the new contour point. 

Now we need to take a look at this in more than two dimensions.  
Click on the 3D-View tab; you should see something like that 
below. 

Note that 3D-View has automatically cut the terrain away to 
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compensate for the existing track in both the upper and lower level loops (if the overlapping terrain is not cut 
away as needed, you need to consult the 3D-View Options and make sure Terrain Follows Track is enabled).  
Move the view around to examine this from as many angles as you need to see.

Now lets add another mountain, this time in the blank area at the lower right.  Set the current contour height to 
14 inches this time, and repeat the steps that you carried out above for the next point.  You should have 
something like that at left.  Before taking a look at the new terrain in 3D, place the mouse pointer over one of the 
contour points and pause for a second, just as you would a piece of track or an accessory.  

Terrain View shows a hint window that tells you the contour item type as well as it's height (18 inches for the first 
point and 14 for the second).  Further, if you right-click you get a shortcut menu that lets you 
do, among other things, alter the contour height.  Before we add some more trees, first go 
and take a look at the 3D tab. 

Notice that the upper level track has had 
an embankment automatically cut away 
between both contour peaks.  You can go 
ahead and add more points, or move the 
existing ones around, or change their heights if you want (to 
change a contour height, select it with the mouse pointer and 
then pull down the Action menu and choose Set Contour 
Height, or right click over the contour you want to edit and 
choose Set Contour Height from the shortcut menu. 

You can 
also 
take a 

look at the data sheet window, which is a list of all of the 
terrain objects in the layout.  Here we show six base/bench 
units and two contour objects with their heights and 
locations.  Notice also that the total area of the layout 
bases/benches is just under 57 sqft.

Tunnels

Just to show how tunnel portals work, we will add a couple on the upper level of track, 
between the two mountains and between the two overpasses.  Go back to Plan View.  
You should still be in the buildings layer.  Pull down the Objects menu and choose tunnel 
portal from the Buildings submenu.  Move the tunnel portal over the 
track junction  just below the left side overpass, and then rotate it 
around ( by your method of choice, see rotating objects ) until you 
have something like that at left. The ‘arrow’ on top of the portal 
designates the outward direction. Don’t worry about the height, tunnel 

portals automatically get their base height from the track below them.  

Now do the same ( another tunnel portal ) for the track junction that is immediately to the left of the lower 
overpass.  Finally, hover the cursor over the curved track 
sections between the tunnel portals ( one at a time ), right 
click and choose toggle tunnel from the shortcut menu.  
When you are done, Plan View should look like that at right.  
RR-Track indicates that track sections have tunnel attributes 
by drawing them with dashed lines.  Tunnel attribute means 
that Terrain View and 3D-View are free to let terrain flow 
over these track sections, as if they were ‘under’ the terrain. 

Shown at left is a 3D rendering with one more contour height 
point added and a few trees.  While you are in the 3D-View, 
move your vantage point around an examine the hill from a 
number of different angles.  You can customize the terrain as 
much as you like, here were are using a small number of 
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height points. 

This ends the fifth part of the RR-Track Tutorial.
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Getting Started Part Six:  Running Trains

 
Now its time to do something a little different and simulate running some trains on our demonstration layout.  
Above is the Simulation View of our layout ( you get this by clicking the Simulation View tab ).  The 
background is pale yellow, layout base/bench units are in light green, over pass track is bold, and switch throws 
are in red/green ( depending on their state ).

There are no trains yet, so the Train List is empty.  Start by pressing the New Train button at upper right.  This 
gets you the New Train Builder dialog, like that at right.  You can build as large a consist as you like, but we 
want to start off simple.  Press the + sign next to the Locomotives heading in the left pane to get a list of 
available motive power.  Go down the list and highlight SW1500 diesel switcher and press the Add>> button. 
You should now have a single entry for an SW1500 in the right pane, which is your assembled train.  Press OK.  
RR-Track changes the cursor to  and puts it in the center of the simulation overview window.

We want to place this train on track on the lower loop because that is where we have a couple of turnouts to play 
with.  Move the cursor down to some of the straight track near the bottom of the loop and hover it.  All track 
sections needed for the initial route track will highlight in green and the cursor will change to  indicating you 

are allowed to place this consist at this location. Click the left mouse button to drop the SW1500 on the track at 
this location.  You should have something that looks like that at left.  .There are 
several things to note in this figure regarding the SW1500 consist.  First, all track 
considered as route track ( track the consist is either occupying or about to occupy ) 
is highlighted in yellow.  Second, the direction of travel 
is marked by the end of the locomotive that has a 

headlight ( this is true even of steam power where the motive unit has both an 
engine and a tender, reverse has lights on the rear of the tender ).  Third, the 
direction light is white which means this train is ‘  live’  , i.e. has a cab to control it.  A 
red direction light indicates a train is ‘dead’ and can’t be moved ( yet ).  

The figure at right shows an abbreviated version of the Train List window, which is 
on the right side of Simulation View.  There is a single train listed “T1: SW1500 
diesel switcher”.  T1 means it is the first train on the train list.  Train’s take their 
names from the name associated with the first powered unit in the consist, unless 
you choose to change the name to something you want.  T1 is in red because it is 
live, dead trains are in black.  

Since this train is live, it has a cab, which was automatically created and attached to 
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this train when we placed it on the tracks.  At right is a depiction of the cab associated with our train with the 
various controls annotated.   At the top is the current speed, in scale MPH.  Below that is the name of the train 
the cab controls.  The slider at left is the throttle, used to set the current speed.  A pair of push buttons set the 
direction ( fwd/rev ), and a small window below that denotes the speed limit ( which depends on the motive 
power ) for this consist.  The Done button lets you close a cab out and make the associated train dead.

The final set of controls which play a part in the train operation simulation are the 
simulation start - stop buttons located just above the train list window.  Above these 
is the simulation clock, which shows you how much simulated time you have spent 
running trains ( this is not the same as a fast clock for model RR clubs ). When Sim 
OFF is depressed, the clock stops and nothing moves.  This is like pushing a crash 

stop button on a real model RR which cuts electric power to the track.  Pressing Sim ON is like applying 
power to the track.  Right now, Sim OFF should be pressed.  You can see this interaction for yourself by 
grabbing the throttle slider and moving it downward so that the current speed indicator no longer reads 00 
mph.  The SW1500 still does not move because we haven’t started the simulation clock.  Before we start, 
return the throttle to the top of its travel so the current speed read 00 mph, unless you are partial to jack-
rabbit starts.

Now press Sim ON to start the clock ( apply power to the track ).  The simulation clock turns on and immediately 
begins to update every second.  The SW1500 still does not move; so grab the throttle with the pointer and move 
it down to read about 10 mph.  The SW1500 immediately begins to move to the left, adding route track in front 

and dropping it behind as needed.  When you get to the first set of curves, stop the 
simulation clock ( press Sim OFF ) so that we can take a look.  The route track sections 
are both O31 curves ( where we stopped it ) and there is a significant amount of overhand 
on the outer rail at each end with some underhang at the center of the inside of the curve.  
One of the questions that comes up frequently in discussions of layout design is 
clearances on curves ( concentric or otherwise ) between tracks and between track and 
wayside objects such as signals, structures, trees, etc.  You can get some answers to 

these questions by right-clicking on the SW1500 train unit and choosing TU Properties ( not Train properties ) 
from the shortcut menu.  If you do that right now you will get Train Unit Properties dialog like that at right.  

First things:  ID refers to the internal TU ID that Simulation View uses on this train, while Pos is the numerical 
location in the consist ( starting at the front ) for this TU ( obviously for a one 
unit train that is 1 ).
Dist run:  distance traversed by this train unit during the simulation in scale 
miles -- 0.028 here.
Time run:  time ( hrs:min:sec) this train unit has been run ( 14 seconds in 
our case, this only includes time at non-zero speeds).  
OVERHANG group
cntr-cntr:  the distance at the front and rear between the center of the car 
body and the centerline of the track.  This is a function of the curved radius, 
the truck spacing, and the front/rear car body overhang past the truck 
centers.
plus width:  the above dimension with the half-width of the car body 
added.  This is now the overhang past the track centerline.
past rail:  the number you may actually want.  This is the previous 
calculated distance with the track width taken into account, i.e. how far the end of the car body hangs beyond the 
outer rail.
UNDERHANG group
cntr-cntr:  the distance at the mid point between the trucks between the car body centerline and the track 
centerline. Like the overhang, this is a function of the curve radius, and the truck spacing.
plus width:  the above number plus the half-width of the car body.  This is how far the car body extends inside 
of the track centerline.
past rail:  as for overhangs, the above number with the track half-width accounted for.  This is the distance the 
car body extends inward past the inside rail. 

So at the center of this sharp, O31 curve ( an R-07 curve approximately for HO railroads ), a relatively short yard 
switcher extends nearly 1 inch past the inside rail and about 1.2 inches past the outside rail on each end.  The 
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moral of the story is don’t put signals next to the track on the either side of O31 curves, unless you want to shove 
them aside with your expensive, scale SW1500 switcher, never mind something with a longer wheelbase  ( SD-
80? ) or longer front/rear overhangs ( 4-8-4 steamers ).  You can let the SW1500 proceed well into the next set of 
straight track ( to minimize clearances ) and then stop it to see the minimum overhang/underhang values.  

Go ahead and run the SW1500 around the upper part of the loop, until you 
nearly reach the O31 RH turnout, stopping before the turnout itself is added 
to the route track ( highlighted in yellow ).  Right now, the turnout is set so 
that the SW1500 will proceed from the turnout entrance to exit along the 
mainline, that is the meaning of the heavy green line drawn along the thru 
track.  Hover the pointer over the turnout so that it changes to  .  This 

cursor means that you can change ( toggle ) the switch state by clicking the left mouse 
button.  Do this once; you should now have a turnout throw state that looks like that at 
right.   Now the switch state is drawn along the spur track in heavy red.  If the SW1500 
enters the switch now, it will take the track to the right.  Click it again and the turnout throw 
state returns to the thru track.  For all two-state turnouts ( this includes Wye turnouts ) you 
can go back/forth between throw states by clicking on the turnout.  

Note:  you do not have to stop trains or suspend the simulation clock to change turnout throw states.  
You can do this ‘on the fly’ while trains are in motion as long as the turnout is neither occupied, nor 
already included in a train’s   route track   ( outlined in yellow ).  If you hover the cursor over an occupied 
turnout you will get this cursor   , which means the turnout cannot be toggled between throw 

states.  You can also zoom in and zoom out, as well as pan and scroll the view around the simulation 
overview window while trains are running.  If the track arrangement is tight and the trains are moving 
fast, you have to be on your toes.

Click the turnout one more time to choose the spur track ( red throw state ) and press the 
Sim ON button to resume the simulation clock.  Watch as the SW1500 proceeds through 
the turnout, adding it to the route track and then traversing the spur like that figure at 
right shows.  As the lead truck nears the exit of the turnout, RR-Track adds the next track 
section to the route list, and drops unneeded trailing track sections.  Continue to let the 
SW1500 proceed down to the next turnout, where it will enter the turnout from the 
nominal exit track end rather than the entrance track end.  Here we have a different 

situation; the O31 LH turnout’s throw state is set for the thru track, 
but we are coming in on the spur track.  We could go ahead and toggle this throw state as 
well, but we don’t have to:  RR-Track assumes all turnouts are non-derailing and will 
adjust the throw state as needed to keep the train on the track.  Watch as the SW1500 
enters the turnout and the throw state changes to the spur track.  Go ahead an let the 
SW1500 proceed around the loop, but go up 
and toggle the upper turnout throw state so it 
has to take the outer path, as shown in the 

figure at right.  There is no need to toggle the lower turnout since all 
turnouts are non-derailing; RR-Track will change it’s throw state as 
needed.  Go ahead and run the SW1500 around the loop some, and 
then move to the next section where we manipulate more than one 
train. 

Making and Breaking Trains

Go ahead and stop the SW1500 about where you originally placed it 
on the tracks.  Right click it on and choose Train Properties ( rather than TU properties ).  This brings up the 
Train Properties Dialog, like that at right.  

At the top is the name of the train, which you can edit and change by pressing the Edit Name button and typing 
in a new name.  Below that is a list of all of the train units in the train consist ( in this case only one).  The train 
units are in numerical list order with their type, description, and lengths shown.  The length is a combination of 
the distance between the trucks over the length overall.  
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Below the train unit list are 10 fields showing various statistics about the 
train.  
#TU:  this is the number of train units.
Len:  the overall occupied length along the tracks.  For this single SW1500 
train unit, this is 6.0 inches, the truck separation.
ID:  internal identifier that RR-Track creates for its own use.  Below this is a 
field that specifies whether the train is live or dead.
Cpl:  number of coupling/uncoupling operations carried out by this train.
Crnt speed:  the speed setting, in MPH.
MAX speed:  the throttle speed limit, in scale MPH.
Avg speed:  average speed this train has run at during the simulation.
Run tm:  total time this train has been in motion ( at a non-zero speed ).
Run dst:  total scale distance this train has run.

Time to put some other train units on the track and play around.  Go back 
and press the New Train button to bring up the New Train Builder dialog.  
This time we are going to make a non-powered set of revenue cars that we 
will ‘pick up’ with the SW1500.   Click the + sign next to the Freight category 

and highlight 40ft box car from the list of revenue 
cars.  The press the Add>> button to move it to the 
train unit list on the right.  For variety, next highlight a 
40ft PS-2 hopper car and add it to the train unit list.  
You should have a list like that at right. Press OK and 
then place this new train on one of the sets of track between the two O31 
turnouts as shown at left.  Exactly where they are placed isn’t that important, nor 
is whether they are on the inner or outer sets of track ( could be called a passing 
siding).  Now we need to go get them and assemble them with the SW1500 we 
already have.  Before we start, note that the Train List now shows two trains, the 
SW1500 in red ( because it is live ) and the train “T2: 40ft box car” in black 

because it is dead.  Our cab is still connect to the SW1500 so we are ready to go.  

Note: we could connect our cab to the two revenue cars, even though they do not have a powered train 
unit with them.  This is because, for the purposes of positioning consists for yard simulations, etc., it is 
sometimes necessary to move non-powered consists.  RR-Track lets you do this, but limits the maximum 
speed to 10 MPH.

Go to the SW1500 cab and press the Rev pushbutton, you will see Simulation View change 
the end of the SW1500 that has a headlight, indicating the direction.  Now press Sim ON ( if 
it isn’t ) and advance the  throttle slowly and start backing the switcher down towards the 
parked revenue cars.  Make sure that the O31 LH turnout is set so that the switcher can in 
fact get to the parked consist and not go around it.  When you get close (i.e. the SW1500 
route track overlaps route track taken up by the parked revenue cars), Simulation View 
outlines the potentially colliding train units in red  ( as shown at left ) and flashes a warning 
symbol in the cab.  When the couplers overlap, RR-Track stops the encroaching train ( this is 
automatic ) and asks if you want to couple the trains.  Press the Yes button.  The two 
consists are coupled into one consist.  Train direction is also automatically reversed, 
note the headlight on the other end of the SW1500.   Also, a peek at the Train List 
shows we now have one train; before we had two trains.  You can take a look at the 

Train Propertes dialog by right-clicking somewhere on the coupled train and choosing Train properties from 
the shortcut menu.  The newly coupled train inherits the properties of the SW1500 since it was the powered train 
of the pair of trains coupled up.

Go ahead and take it out for a spin, the three-unit train consisting of the SW1500 plus the two 40ft revenue cars.  
The coupling operation we just carried out is key to making and breaking trains in Simulation View.  You can 
build up trains by moving around a yard with a switcher, just as you 
would on your actual train layout.  After a bit, bring this train to a 
stop somewhere so we can uncouple cars.  Move along the train 
consist hovering the cursor.  When you are over a train unit the 
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cursor changes to   and a pop up hint window appears detailing both the train name and the position and 

description of the train unit under the cursor.  As you hover over the coupler bar between train units, RR-Track 
changes the cursor to  suggesting it is possible to uncouple these train units.  

Position the cursor between the last two revenue cars, wait for the uncoupling cursor, 
and click the left mouse button.  RR-Track uncouples the two cars, breaking the train 
into two trains, as you can see from the Train List at left.  A slow advance of the cab 
throttle pulls the SW1500 and its entourage of 

one box car away, like we have at right.  You can easily put this train back 
together by stopping, and then backing down and re-coupling, like we did 
when the train was assembled.  Instead of doing that, hover the cursor over 
the SW1500 train and right-click to bring up the shortcut menu.  Choose Flip Train direction.  This reverses the 
order of the train units in the train, and changes the train direction as well, although you could look at it as 

preserving the train direction.  You should have something like that at 
left after flipping the train.  Now if we advance the throttle we will be 
able to couple the PS-2 hopper to the front coupler on the SW1500.  
Go ahead and carry this operation out, you should have a train that 
looks like that below.

Now you have the SW1500 in the middle of the train consist, this is 
irrelevant to RR-Track as long as there is a powered train unit in the 
consist.  This is not an uncommon configuration for a switcher on yard 
duties, pulling some train units all the while pushing others as it goes 
about its business of making and breaking trains.

Our demonstration layout is really quite tight when it comes to using larger sized 
equipment.  You will note that train operations were demoed with a yard switcher 
( SW1500 ) and 40ft revenue cars, relatively short for modern time periods. Even 
though locomotives and cars exist that can navigate sharp, O31 curves, it is instructive 
to try and place a train on this layout that is build from larger equipment.  Go back and 
press the New Train button and use the New Train Builder dialog to construct a 
consist like that at right.  Press OK and place this on some of the track at the left side of the lower level loop. 

RR-Track will let you place this train, but it is obvious that 
there is no way you are going to get anything close to 
realistic operation out of 80ft passenger coaches on a 
layout with O31 curves.  The underhang for the first coach 
car is more than 2.75 inches past the rail while the 
overhangs at each end are 1.5 inches past the outside rail. 
Given the extreme coupler angles at car-car junctions on 
the curves, it is unlikely that a real train would stay on the 
track, pushed or pulled.  

We could just as well have run our test trains on the upper 
level, but with no turnouts on our demo design, it was more 
instructive to show train operations on the lower level.

This concludes the six part RR-Track Tutorial and layout 
design.
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RR-Track Views
When you open or start a train layout, RR-Track creates a master layout window which is a container for five 
different views of, or ways of looking at, your layout plan.  Each of these views may be accessed by clicking on 
the appropriate tab along the top of the master layout.

 Above is a typical RR-Track 
layout window with the five views 
and their associated tabs.  These 
ways of viewing your layout are 
( L/R): Plan View, Component 
View, Terrain View, 3D View, and 
Simulation View.  Pressing on 
each of these, in turn, will display 
the associated view of your train 
layout.  

You do your positioning of track, 
accessories, and other items 
( scenery, roads, buildings) in the 
Plan View tab.  The Component 
View tab shows all of the items 
that make up your train layout, 
split out by manufacturer.  The 
Terrain View is used to position 
layout bench units ( bench work) 
and terrain features.   The 3D 
View is used to get an idea of how 

your train layout will appear.  Finally, the Simulation View lets see how your layout design will run trains in an 
interactive environment.  Together, these five views present a comprehensive examination of your train layout 
design.

To change from one view to the other you simply click the tab with the appropriate name, for example, if you are 
working in Plan View and want to look at the component breakdown of your layout, click the Component View 
tab.

Plan View
This is where it all starts, and mostly lives, the 2D Plan View of your layout.  This is a view from above, showing 
the relationship of the components in your layout to each other.  In the Plan View you do all of your positioning of 
track, accessories, objects such as scenery, roads, create and remove grades.  With the exception of the Terrain 
View, all manipulation of layout components  occurs in Plan View.

All views but Component View in RR-Track also have an associated status bar where you may quickly access 
the most needed features for that view.  Below is a folded image of the Plan View status bar:

There are nine displays/controls on the Plan View status bar:

Pointer Position:  layout coordinates of the mouse pointer.

Zoom Factor:  ranges from 1 to 128.  See the essay on changing the zoom for more information,

Extended Selection Mode:  push button displays a list letting you choose the extended selection mode.

Automatic Track Joining:  push button lets you toggle automatic track joining on/off.
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Automatic Loop Closing:  push button lets you toggle automatic loop closing on/off.  See closing track 
loops for more information.

Snap Size: push button toggles using a snap setting on/off; clicking over the uparrow displays a list 
letting you choose the current snap grid size.

Working Layer:  shows the name of the current working layer;  clicking over the uparrow lets you 
choose another working layer or set the visibility attributes of any current layer.  Double-clicking invokes 
the Drawing Layer Setup dialog which allows you to configure any layer or add and remove layers.

Info Box:  shows the item the pointer is hovering over.

Last Item List:  push button gives you another instance of the last track/accessory item added from the 
Track or Accessory menu.  Pressing the up-arrow displays a list of the last 10 distinct items any of which 
you may choose to add to the current layout.

Plan View Windows
The Plan View is dominated by 
the 2D plan view of your layout.  A 
typical layout plan view is shown 
at left.  This is where you add 
track, delete track, move track 
sections around, insert, edit and 
remove scenery objects, and just 
about any other item that is part of 
your layout design.  

There are also several auxiliary 
windows and lists that can be 
visible as well when you work in 

plan view.

Overview window:  the overview window is what it is named, an overview of your 
entire layout regardless of how your are zoomed in in Plan View.  When you are 
zoomed in, the overview window shows a small, dotted line rectangle that depicts 
how much of the layout your current field of view covers.  You can move the view 
around by hovering the cursor over the view rectangle ( changes to a crosshair 
indicating you are over the view rectangle), and dragging it by depressing and 
holding the left mouse button.

Hot Item List window:  the Hot List window contains up to 20 items from any 
library that you may customize for quick, one-click access to your most used 
items.  You can edit the list as needed, see Hot Item List for more information.

Selected Items List:  this window, displayed 
when you choose the Show Select List 
command from the View menu, shows all of the items that are currently 
selected, their individual lengths, and their combined lengths.  This is useful 
for checking the lengths of sidings to see if they will accommodate the 
consists you plan to run.  The data sheet is similar to the layout of 
Component Viewer.  You can expand / collapse each item by clicking on the 
box next to its name, the can expand/collapse all items using the second and 
third buttons on the toolbar above the data sheet, and you can print a list of 
the items by pressing the button with the printer icon.

Current Modules window:  here you have a list 
of the modules that are currently available for 
addition to the layout.  You can add a module, like 

a big piece of track, by selecting it from the module list.  For more information on 
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using modules, see the article on module compiler. 

Plan View Menu Bar
The Plan View has a menu bar divided up into commands under File, Edit, Action, View, Track/Accessory, 
Objects, Fonts, Grades, Library, Options, Window, and Help.

File menu:
New Layout...: creates a new layout design.
Open layout... opens an existing layout design.
Close:  close the active layout design. If changes have been made since the last save, you will be 
prompted to save your design.
Save:  save the active layout design. You should save frequently.
Save as...  save the active layout design under a new name.  This is good for creating variations on a 
theme.
Save all:  save all open layout designs.
Print layout...  print all or part of the layout plan view.
Printer setup... calls the Printer Setup dialog provided by the current printer driver.
Clone layout:  creates a fresh copy of your layout design and opens it in a new master layout window.
Create module...  takes the current layout design and passes it to the RR-Track Module compiler so that 
you may turn it into a RR-Track module.
Export:  copies the image of the current plan view to either a standard bitmap image file (.BMP) or 
copies this bitmap image to the Windows Clipboard.
Exit:  closes all RR-Track windows and terminates the RR-Track application.

Edit menu:
Undo last track:  removes the last track or accessory item added to the layout design.
Step back:  backs the layout design configuration to the previous restore point.
Cut:  removes the selected items from the layout and places them in the RR-Track clipboard.
Copy:  copies the selected items to the RR-Track clipboard.
Paste:   pastes the contents of the RR-Track clipboard into the layout design.
Repeat paste:  pastes the clipboard contents at locations you designate with the pointer.  Press the ESC 
key to exit this command.
Delete:  deletes the selected items.
Duplicate:  copies the selected items to the clipboard and then pastes them back into the layout. 
Duplicate parallel:  lets you duplicate the selected track at a fixed offset from itself.  Useful for initiating 
parallel mainlines and sidings.
Select all:   select all of the items in your layout design, including hidden items.
Select all in layer...select all of the items in a given layer, which you will be prompted.
Select all visible:  select all of the items in the layout design which are visible.
De-select all:  un-select everything that is highlighted.

Action menu:

Rotate...  rotates the selected items.  You can enter an arbitrary angle or choose one of the preset 
angles.  See Manual Rotate dialog for more information.

Move...  incrementally moves the selected items using the Quick Move dialog.

Change height.... sets the absolute height of the selected items.  Heights default to zero.   See Set 
Height dialog for more information.

Move to layer...  moves the selected items from the current layer to one of the other layers in your layout 
design.
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Extrude:  set the vertical dimension for a basic object ( not track or accessories).  See Object Extrusion 
dialog for further information.

Unjoin selected track:  breaks the track junctions between the selected track components and the rest of 
the track in your layout.   Does not alter the physical location of the selected track.

Join to nearest track:  joins the nearest unoccupied compatible track junction on the selected track items 
to those on your layout design.

Close contiguous loop:  finds and closes gaps between track junctions in the selected track items.  Does 
not alter the physical position of the track.

Break joint:  breaks the joining between the track sections at a junction you designate with the pointer.

Align:  these three items let you align track and objects with other items.

Align to -> Coordinate Grid:  aligns the an edge of the selected item(s) with the underlying layout 
coordinates.

Align to -> Designated Object:  aligns an edge of the selected item(s) with an edge of an item you 
designate with the mouse pointer.

Align to -> Nearest Track:   aligns the selected track with the nearest compatible track.  Like joining 
without actually coupling these track sections.

Group objects:  groups the selected objects together.   Does not apply to track or accessory items.  See 
grouping and ungrouping objects for more information.

Ungroup objects:  ungroups the objects in the selected group.

Move to front:  moves the selected items to the top of the display list, where they will be drawn last and 
appear on top of those that are drawn before them.

Send to back:   moves the selected items to the bottom of the display list where they will be drawn first, 
underneath other items.   Terrain items are always at the bottom of the display list.  For the above two 
commands see changing the drawing order for more information.

Set/clear block break:  sets or removes a soft electrical block break at a track junction you designate with 
the pointer.

Clear all block breaks:  removes all soft electrical block breaks in the layout design.

Create block:   sets a soft electrical block break at the ends of the selected track.

Lock selected items:  locks the location, size, orientation, attributes of the selected items.  You must 
unlock the items to change any attributes.

Unlock selected items:   removes the lock status of the selected items so you can alter their attributes.  
More discussion on these two commands may be found in locking and unlocking items.

Relax selected track configuration:  lets you adjust the position of the selected track to minimize gaps 
and alignment errors.

The Action menu will only be available if you have selected an item for RR-Track to act 
on.  If no items are selected ( highlighted ) this menu is grayed out.

View menu:

Zoom in 2x - Zoom in 4x: lets you double or quadruple the screen scale.  The exact zoom area you 
designate with the mouse pointer.

Zoom out 2x - Zoom out 4x:  zooms the view back out by a factor of two or four, to a maximum of 1:1 
( entire layout visible).  For more information on the zoom commands, see zooming the view.

Last view: return you to the previous view.   Handy for toggling between zooming in to look at something 
in detail and then backing out for a wider view.
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Home view:  zooms back to 1:1 to display the entire layout

Fit in window:  both zooms back to 1:1 and rescales the layout to make better use of the window aspect 
ratio.

Redraw:  forces a redraw of the layout.

Show locked items:  selects ( highlights ) all locked items.  Good to use before unlocking all locked 
items.  See locking and unlocking items for more information.

Show overview:  toggles the display of the layout overview window.

Show status bar:  toggles the display of the status bar at the bottom of the screen.

Show select list:  toggles the display of a summary of all currently selected ( highighted ) items.  You can 
use the infomation in the Select List window to check siding lengths among other things.

Show hot list:  toggles the display of the Hot List, which gives you one-click access to track/accessory 
items of your choosing.

Show modules:  toggles the display of the Module List, which gives you one-click access to any modules 
you have created.

Show display list:  brings up the Display List.  This is a linear list of all objects in your layout in drawing 
order ( first to last).  You can individually access and remove hard-to-find items from the display list 
through the Display List dialog.

Switch to 3D:  switch to 3D layout view.  Same as clicking the 3D View tab.

Switch to Terrain map:  switch to the Terrain View  Same as clicking the Terrain View tab.

Switch to Component View:  switch to Component View showing your layout inventory.  Same as clicking 
the Component View tab.

Object menu:

The following choices are available for Basic shapes:

Outline rect:  rectangle with unfilled interior. 

Filled rect:  rectangle with filled interior.

Cross-filled rect:  rectangle with filled interior and cross lines from corner to corner.

Outline circle:  circle with unfilled interior.

Filled circle:  circle with filled interior.

Simple line:  single-segment line.

Poly line:  multi-segment line.

Wide line:  multi-segment, variable width line.

Tangent line:  a dashed line that is indexed to the postion and angle of a track end.  Used for design and 
notional purposed.

Outline polygon:  polygon with unfilled interior.

Filled polygon:  polygon with filled interior.

The following choices are available for Buildings:
flat building:  rectangular building with flat roof.

simple building:  rectangular building with simple barn-style roof.

hip-roof building:  rectangular building with hipped roof.

water tower:  square footprint RR-style water tower.
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turntable:  generic circular turntable.

tunnel portal:  a single track tunnel portal you can position to show the entrance/exits of your tunnels.  
Tunnel portals are used by both the Terrain View and the 3D View to establish terrain heights.

girder bridge:   simple girder-style RR bridge.

plate bridge:  simple plate-style RR bridge.

truss bridge:   over-the-track style truss bridge.

The following choices are available for Scenery:
Yucca tree:  pointy southwestern style scrub tree.

bush:  generic roughly circular low shrub.

evergreen tree:  confier style tree.

fall tree:  bright colored deciduous tree.

spring tree:  green colored deciduous tree.

random tree:   trees are selected at random from the three styles above.   Useful for quickly filling in a 
mixed plantation.

plain boulder:   constant color six sided rock.

random boulder:  random color six sided rock.

4-tone heap:  conical heap with lighter shade towards the top.

pond:  polygonal body of water.

river:  linear body of water.

2-lane road:   single striped road.

4-lane road:  triple striped road.

country road:  non-striped road.

The following choices are available for Special objects:
Text label:

Font menu:

Track labels:  font used to draw the labels on track and accessory items.

List windows:  font used in lists, such as the Selected Items List.

Status bar:  font used by all the status bars

Grade menu:

Create grade:  this takes the selected track sections, examines the height of the first non-selected 
connected track at each end, and interpolates all the intermediate heights.

Set track height:  sets the absolute height for the selected track.  This is used to establish heights at 
various points on your layout design which are then connected with grades.

Zero track height:  set the selected track height to zero.

Grade information:  displays information about the selected grade track, such as length, vertical relief, 
and per cent grade.

Calculator:  used to game out the trade-offs between grade length, vertical relief, and grade per cent.

Show grade track:   highlight all track that is on a grade.  This is not the same as elevated track, see 
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grade track.

Show elevated track:  highlight all track sections not at zero height that are not part of grades.  See 
elevated track. 

Library menu
The Library menu consists of a list of all of the track/accessory libraries you purchased/installed in your 
RR-Track system.  These are sorted by gauges, with accessories ( i.e. trackside structures) at the 
bottom.  A check mark indicates the current active library.  Only one library may be active at any time, 
however you may store items from any library on the Hot Item List, or tearoff and paste menus from any 
track/accessory library onto your desktop.  To change the current library, pull down the Library menu and 
choose the track/accessory system that you want to make active.

Using these methods, it is possible to have components from more than one library available at any 
given time

Options menu:

Resize layout:  lets you increase/decrease your layout size.  This just sets the size of the ‘sandbox’ you 
have to work in, it does not dictate the shape/arrangement of your actual layout benches/platforms.

Layers:  lets you add/remove layers from your design, change existing layers names, and assign 
visibility attributes to your layers.

6in/12in/24in/48in/10ft/No grid:  choose the size of the coordinate overlay grid.

Detailed track render:  when checked, track is drawn with full detail, i.e. correct number of rails.  When 
cleared, only the track centerline is drawn.

Label track:  show track labels.  The location can be specified under Layout Options.

Snap objects to grid:  make item origins snap to a hidden set of location points with a specified spacing.

Set snap size:  choose the spacing of the underlying snap points.

Auto-join new track:  enabled newly added track sections to automatically be joined to the closest 
compatible existing track.  Also enabled automatic joining when moving around existing track sections.

Automatic loop closing:  when checked enables automatic checking for and closing of track loops ( like 
ovals, figure eights, anything that comes back to itself).

Selections include joints:  sets the extended selection mode to include all track physically joined to the 
selected track.

Selections include blocks:  sets the extended selection mode to include all track that is both physically 
and electrically connected to the selected track.

Selections include grades:  sets the extended selection mode to include all track that is physically 
connected and on the same grade or at the same elevation.

Options:  brings up the Global Options dialog.   This is used to set RR-Track options that affect all 
master layout windows.

Repair track joining:   disconnects all track and then rejoins it using physical proximity.  Sometimes good 
for getting you out of some situation you don’t know how you got into.

Show restore points:  shows the current set of restore points.  RR-Track remembers the last 20 restore 
points.  Use the Step Back command under the Action menu to go to the previous configuration.

Window menu:

These are all standard Windows multiple document window commands.

Cascade:  arranges all master layout windows in a cascade starting at the upper left corner of the RR-
Track application window.
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Tile:  arranges the master layout windows in a tiled patter in the RR-Track application window.

Arrange icons:  organizes all of the minimized master layout windows.

Close all:  closes all open master layout windows. 

Help menu:

Contents:  opens the RR-Track Help system to the contents page.

Search for help on:  opens the RR-Track Help system to the search page.

Getting started:  opens the RR-Track Help system to the track laying tutorial.

Check for RR-Track updates:  starts your web browser and goes to the RR-Track 5.0 updates page on 
the RR-Track website, www.rrtrack.com.

Curve calculator:  opens the Curve Calculator help system.

Turnout calculator:  opens the Turnout Calculator help system.

About RR-Track 5.0...:displays RR-Track build number, serial number, libraries and modules information.

Tearoff Menus
RR-Track provides multiple ways that you can use to access track and accessory items for addition to your 
layout design.  Tear-off menus are a feature of RR-Track that give you another way to quickly access track and 
accessory items during layout design.

One method is to pull down the Track/Accessory menu and choose the item you want from the sub-menus for 
that particular library.  For libraries with many items ( some accessory libraries have nearly 400 items ), 
repeatedly going to the main Track/Accessory menu can become tedious.  A second method is to go down to the 
Plan View status bar, move over to the Last Item list on the far right, click the uparrow to bring up the Last Item 
list, and choose from among the 10 most recent distinct additions.  A third method is to populate the Hot Item 
List with up to 20 of your favorite components from any library and choose from there.  All of these have their 
strengths and weaknesses.  Using the main menu allows full access but navigating 
the nested menus can be tedious.  Bringing up the Last Item list and choosing 
requires two clicks and what you need may not be among th the last 10 items.  The 
Hot Item List must be pre-populated, is limited to 20 items, and you may not want to 
temporarily add components here.  This brings us to the Tear-Off menu.

Tear-off menus apply only to sub-menus of track and accessory libraries.  None of the 
other Plan View menus implement tear-off capabilities.  When you tear off a menu, 
you can position it anywhere on your screen; tear-off menus support docking on the 
inside left/right edges of the main RR-Track application window.  You can have as 
many tear-off menus as you can stand to clutter your screen.  An example of a tear-
off menu is at right.  Any tear-off menus you have are only visible when working in 2D 
Plan View, all other views hide tear-offs ( if any ).

To Tear Off a Menu

• Pull down the Track/Accessory menu.  

• Position the cursor over the desired sub-menu so that Windows displays it. 

• Place the cursor over any item on the sub-menu and click with the right-mouse button. 

• RR-Track creates a tear-off menu which you can then position where you prefer by dragging it to 
its new position like you would any other window.  

If you move the left/right edges of the tear-off menu near the left/right borders of the RR-Track application 
window, they will automatically dock to that window border.  When docked, tear-off menus move when you move 
or resize the RR-Track application window, preserving your layout.  If undocked they remain in place on your 
display.
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To Choose an Item

• Position the cursor over the tear-off menu that contains the item you want to add. 

• Click the left mouse button.  RR-Track positions the cursor with the item beneath in the Plan 
View window just as if you had chosen the item from the Track/Accessory menu. 

You can remove a tear-off menu by clicking the X button on the tear-off caption.

Note:  RR-Track does not remember any tear-off menus between sessions.  You will have to re-
create them if you need them.

Component View
Component View is a flat-file 
database of the items from the 
various manufacturers that 
comprise your layout design.

You can view a summary of all of 
the components organized by 
source ( manufacturer ), or click 
on tabs that display each 
manufacturers contribution to the 
layout design.  Alternatively, you 
can have Component Viewer split 
items by layer.

There is a toolbar along the top of 
Component View that gives quick 
access to commonly used 
commands.   The menu bar lets 
you access all commands 
available in Component View.

To Show a Summary of all Layout Components

• Select the All tab 

To Show a Specific Manufacturer’s Components

• Pull down the Options menu and choose Sort Items by Vendors 

• Select the vendor’s tab that you want to study. 

To Show a Specific Layer’s Components

• Pull down the Options menu and choose Sort Items by Layers 

• Select the layer tab that you want to study. 

When in either a vendor’s tab or a layer’s tab, you can show all of the items of a given ID by clicking on the + 
symbol.  To collapse the individual items press the - symbol.  You may also apply this to all items.

To Expand/Collapse all Items

• Pull down the Options menu and choose either Sort Items by Vendors or Sort Items by Layers. 

• Select the vendor or layer tab you want to study. 

• Pull down the Action menu and choose Expand All Items to show all details or Collapse All Items to 
show summaries. 

The above commands may also be accessed from the toolbar along the top of the Component View.
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To Print a Tab

• Pull down the File menu and choose Print Item List.   Component View invokes RR-Print where you 
can choose how you wish your component list printed. 

Component View Toolbar 
The Component View toolbar lets you access 
eight commands quickly and displays the 
total cost and total number of items on the current tab.  At right of the command buttons are summaries of the 
total cost and number items in ths current tab.

 Press this button to save an item list as a simple text (TXT) file that you can edit with any word processing 
application including MS NotePad.

Press this button to send the current tab to RR-Print for printing. 

Press this button to sort the layout’s components by layers.

Press this button to sort the layout’s components by vendor ( manufacturer ).  This is the default sorting 
method.

Press this button to select ( highlight ) all of the instances of the item entry you have highlighted in 
Component View.

Press this button the de-select all of the instances of an item that you selected.  This is the same as a de-
select all command in Plan View.

Press this button the expand all items in either a vendor or layer tab.

Press this button to collapse all items in either a vendor or layer.

Terrain View
Terrain View shows the layout 
bench units and contour height 
points that together create the 
terrain on your layout design.  With 
Terrain View, RR-Track allows you 
to set up realistic terrain features 
for your layout.  The terrain objects 
you place in your layout interact 
closely with 3-D Viewer to 
automatically generate realistic 
looking topographic features with 
minimal user input.

In the Terrain Overview window 
you can add layout bench units 
(analogous to benches) and 
contour objects, set contour 
heights, modify layout bench and 
contour objects, and remove 

terrain objects.  To do so you use the same methods used to add, modify, and delete items in the Plan VIew 
window.

To switch to Terrain View from Plan View ( or any other view ) just click on the Terrain View tab.

Below is a folded view of the Terrain View status bar:
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Terrain View Status Bar
To the left is a small pane 
that shows the pointer 
position when it is hovering 
over the Terrain Overview 
Window.  The next button, 
as for the Plan View status 
bar, allows you to set the 
snap grid size for the Terrain Overview.  Pressing the uparrow displays a list of snap sizes you can choose from. 
The next button ( default height ) displays the current contour height setting.  Pressing this button displays a 
small dialog letting you input a new contour height.  The default height is used for all subsequent contour objects 
( until reset ).  The third button ( new layout base ) lets you choose to add another layout base by clicking it.  To 
choose a different base, click the uparrow button to show a list of all available base types ( rectangle, polygon, 
triangle, semicircle, quartercircle).  The fourth button ( new contour ) lets you choose to add another contour 
height point(s) identical to the previous.  As for the snap size and new base buttons, pressing the uparrow lets 
you choose from a list of the available contour height point types.

At the far right is the Options button.  Pressing this brings up the Terrain View Options dialog, allowing you to 
customize Terrain View.

Terrain View Windows
Terrain Overview window:  this is 
the main workspace when you are 
in Terrain View.  The primary 
layout components show in Terrain 
View are the track plan, the layout 
bench units ( in green ), the height 
contours ( in yellow ), and sample 
cross-section line.  Other objects 
such as scenery items like trees, 
rivers, ponds, user-created 
structures, and general purpose 
drawing objects are not revealed 
( some scenery items such as 
rivers, lakes, roads may be 
displayed, see Terrain Options 
dialog for more information).

Cross-section window:   this 
window shows a height cross-

section of the layout along the line denoted by the cross-section path  The 
cross-section path is a white line with red dashes as shown above.  You can 
move one or both endpoints of the cross-section path using the Cross-section 
Endpoints dialog accessed through  the Set X-section Endpoints command 
under the Action menu.  Terrain View shows the terrain heights in red, track in 
blue, and points that are not above a terrain base object in yellow.

Terrain Items Data Sheet window:  lists 
all of the terrain objects in the layout along with their relevant parameters; 
these include layout bench units and contour height points.  These may be 
sorted in several ways to meet your needs.

Along with each terrain object, the data sheet window details the height, 
horizontal and vertical positions of the object origin point, the x and y extents 
(size) of the object, the number of points (if open or closed contour, or base 
polygon), the area, and the locking status (whether you are allowed to move 
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or edit the object). 

The data sheet may be sorted by any of the first five columns (name, height, horizontal and vertical positions) by 
double clicking on the title bar above the column.  When you do so, the data sheet sorts in ascending fashion.

If you right-click on one of the terrain items in the data sheet window you get a shortcut menu that lets you:

select:  highlights the item (same as left clicking on it).  Selecting an item deselects any other items that may be 
already selected.

delete items:  deletes the terrain object from the item list.

edit item:  selects the item and invokes the Terrain Item Edit dialog where you can make changes ( using the 
keyboard ) in the item’s properties.

Terrain View Menu Bar
Action menu:

new contour - point:  choose this to add a new single height point.

new contour - open line:  choose this to add a series of points at the same height.

new contour - closed loop:  choose this to add a series of points at the same height in a closed loop 
configuration.

The above commands use the current contour height, and are accessible from the Terrain View status 
bar as well.

new base - rect:   choose this to add a new rectangular layout base unit to your layout design.

new base - polygon:  choose this to add a new polygonal layout base unit to your layout design.

new base - triangle:  choose this to add a new triangular layout base unit to your layout design.  Same 
as above but limited to three vertices.

new base - semicircle:   choose this to add a new semi-circular layout base unit to your layout design.

new base - quarter circle:   choose this to add a new quarter-circularlayout base unit to your layout 
design.

The above commands are accessible from the Terrain View status bar as well.

rotate:  use the Quick Rotate dialog to rotate the selected items.

set contour height:   set the height of the selected contour(s).

set cross-section endpoints:  move the endpoints of the cross-section line shown in the cross-section 
pane.

Edit menu:

copy:  copies the selected terrain items to the clipboard.

paste:  pastes the contents of the clipboard into the Terrain View at the current insertion point.

delete:  deletes the selected terrain items from the layout.

cut:  removes the selected terrain items from the layout and copies them to the clipboard.

select all bases:  selects ( highlights ) all layout base units ( benches ).

select all contours:  selects ( highlights ) all layout contour height points.

de-select all:  deselects everything that is currently selected ( highlighted ).

View menu:

zoom in 2x:  choose this to zoom in by a factor of two.  You can choose the zoom rectangle using the 
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pointer.

zoom out 2x:  choose this to zoom out by a factor of two.

home:  return the zoom to a full view of the layout region.

redraw:  force a redraw of the the Terrain View overview window.

Options menu:

mask base units:  when checked prohibits the accidental selection of layout base units.  Useful when 
only manipulating contours and you do not wish to accidentally select/edit base units.

terrain options:  invokes the Terrain View Options dialog allowing customization of the terrain colors, 
what objects are shown/hidden, which data windows are shown.

Window menu:

cascade:  arranges master layout windows in a cascade.  Standard Windows MDI command.

Help menu:

Contents:  starts the RR-Track v5 Help file at the Terrain View  page.

About:  displays the description dialog for Terrain View.

3D – View
3D View is where RR-Track lets 
you visualize train layout designs 
in a virtual three-dimensional 
space.  3D View minimizes user 
input in taking a layout design 
from the 2D plan view world of 
RR-Track to the virtual three-
dimensional space of 3D View. 
You may change your point of 
view, zoom in or out, move the 
viewing point, change the color 
scheme, and a number of other 
parameters.

You do not manipulate the location 
and orientation of individual track, 
accessory, or other items in 3D-
View (you do that in Plan View), 
but you may examine your layout 

from all angles and all locations.  3D-View automatically generates solid filled or smooth shaded terrain for your 
layout based on terrain information that you provided using Terrain View.  You may choose to have 3D-View 
automatically adjust the heights of scenery items such as trees and buildings to match the terrain features.  3D-
View can also adjust the terrain to compensate for track and accessories letting you visualize features such as 
elevations and tunnels.

Viewing your layout in 3D could not be simpler, simply click the  3D View tab from any of the other views.  You 
can switch back to the Plan View or Terrain View, make some changes to your layout design, and immediately 
inspect them in 3D by choosing the 3D View tab.

Note:  OpenGL is the 3-D graphics rendering system used by 3-D View.  OpenGL is derived from the 
GL2 graphics library created by Silicon Graphics Inc. and is used in almost all high-end graphics 
workstations.
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3D-View Status Bar
The 3D-VIew status bar 
has a number of controls 
giving quick access to the 
most used functions.  At 
left is a pane that shows 
the current azimuth and 
pitch angle of the 3D 

Viewer.  0° is facing the layout along the bottom edge, 90° in pitch is looking straight down.  Following this pane 
is a four-way button that lets you quickly move your viewpoint in azimuth ( L/R) by clicking the horizontal arrows, 
and move your viewpoint in altitude/pitch ( U/D) by clicking the vertical arrows.

The next pane shows the current offset of the view from the layout center.  (0.0, 0.0) means your are looking at 
the very center of the layout.  Following this is another four-way button that lets you pan in x-position ( L/R 
arrows ) and y-position ( U/D arrows) by clicking the appropriate button region.

The third pane shows the current view magnification.  A two-way button is to the right of this pane; clicking the 
(+) region zooms in while clicking the( )- region zooms out. 

At the right end of the bar is the Options button.  Pressing this brings up the 3D-View Options dialog allowing 
you to customize various features of 3D-View.

3D-View Windows
Visualization window:  3D-
View’s windows are dominated 
by the 3D visualization window 
itself.  

Below this is a bar area that 
contains controls for the most 
common viewing orientation / 
magnification / view center 
manipulations.  These are 
located on the left, while there 
are three buttons on the right 
that let you start / stop animation 
and anti-alias the 3D rendering 
for a smoother appearance.  

All of the orientation, 
magnification, and view point 
offsets may be adjusted from the 

status bar as well.  For those that need very fine control of the 3D orientation and magnification, these 
parameters may be adjusted from the Orientation and Center Point dialog as well.

Orientation and Viewpoint

The five sliders below the visualization window let you (from L/R) set the azimuth, altitude, magnification, x-
offset, and y-offset of the view.  You can change these parameters by grabbing the slider with the cursor ( press 
and hold the left-button when you are over the slider ) and moving it from side-to-side along its range.  3D-View 
dynamically updates the visualization window as you adjust the view, showing your entire layout space, layout 
bench units, and track as single line, transparent, filled objects.  When you release the slider, 3D-View renders 
the full scene using the new viewing parameters.

Animation and Smoothing

The three buttons at the lower right ( from L/R ) let you start an animation sequence, stop an 
animation sequence, and smooth the visualization by anti-aliasing.
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3D-View Menus
Action menu

Copy view:  copies a bitmap image of the current 3D view to the Windows clipboard.  From here you can 
paste it into other documents, or edit using various image editing applications.

Save view: saves a bitmap image of the current 3D view to your Windows file system.

Print view:  sends a bitmap image of the current 3D view to RR-Print for printing.

View menu
Redraw:  forces a manual redraw of the 3D view.   Helps to eliminate screen artifacts that can 
sometimes occur under the cursor.

Re-render:  tells 3D View to re-calculate the entire layout scene and redraw it.

Anti-alias:  jitters the point-of-view slightly and averages the resulting renderings to smooth out aliasing 
features such as jagged edges and Moire effects.

Anti-alias more:  a more intense version of the above using 16 scenes.  Only use for serious Moire 
issues.

Show axis:  toggles the appearance of center-point coordinate axes.

Show berms:  builds up berms under elevated and grade track.  Not needed if using layout base units 
with full terrain rendering.

Perspective:  choose this viewing transformation for a 3D rendering that takes into account the distance 
of the observer from the layout scene.  Looks more realistic.

Orthographic:  choose this viewing transformation to get more of an engineering drawing appearance. 
This viewing transformation places the observer an infinitely far distance away.

Set center point:  this command lets you use the cursor to choose the point which the view will be 
centered on.   The center point can also be manipulated using the X-Y slider controls on the 3D View.

Set orientation...:displays the Orientation and Center Point dialog where you can set the exact altitude 
and azimuth angles as well as the precise offset from the layout center for the current view. 

Special views

Left front:  shows the layout from a point 45° to the left and 35° above horizontal. 

Right front: shows the layout from a point 45° to the right and 35° above horizontal. 

Center front: shows the layout from a point directly in front and 35° above horizontal. 

Profile: shows the layout from directly in front. 

Left rear:  shows the layout from a point 135° to the left and 35° above horizontal. 

Right rear: shows the layout from a point 135° to the right and 35° above horizontal. 

Center rear:  shows the layout from a point 180° from the front and 35° above horizontal. 

Left side:  shows the layout from 90° to the left and 35° above horizontal. 

Right side: shows the layout from 90° to the right and 35° above horizontal. 

Overhead:  shows the layout from directly overhead.  Like train magazine views. 

Animation menu
Load path..:  displays the  Animation Path dialog.   This lets you set up an animation path, or load an 
existing path from a file.  

Start:  starts an animation.  You must have loaded an animation path in order for this command to be 
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accessible.

Stop:  stops the current animation.

Resume:  resumes a stopped animation from the stopping point.  This is different from Start which 
begins the animation at the first path point.

Options menu
Skeleton mode:  toggles a basic display mode where only track and bases with no terrain are rendered. 
Vertical lines extend from the layout bases to all elevated track sections to give a sense of the vertical 
relief in the layout.

Options:  displays the 3D Display Options dialog where you can adjust many of the parameters 3D 
View uses in its rendering.

Window menu
Cascade:  standard Windows Multiple Document command that arranges all top-level master layout 
windows in a cascade.

Help menu
Contents:  opens the RR-Track Help file to the 3D View topic.

About RR-View 3D:  displays the RR-View 3D information dialog.

Shortcut Menu (invoked by right-clicking in 3D View)
Rotate left:  rotates in azimuth a small amount to the left.

Rotate right: rotates in azimuth a small amount to the right.

Rotate up: rotates in altitude a small amount to the up.

Rotate down: rotates in altitude a small amount to the down.

Set Center point:  lets you use the cursor to choose the point which the view will be centered on.  

Options: displays the 3D Display Options dialog where you can adjust many of the parameters 3D View 
uses in its rendering.

Simulation View
Simulation View is where you 
can test our your layout design 
and see if it will in fact allow for 
the train operation than you 
envisage.  These include, but are 
not limited to, checking siding 
lengths, checking clearances in 
both storage yards and mainlines, 
switching operations.

Simulation View lets you have as 
many trains as you like, but only 
one cab.   At any given time a 
single train is under cab control 
( moving or stopped ); you may 

switch between trains that are ‘live’ as you need in order to test your layout design.

Limitations:  RR-Track simulator assumes all turnouts are non-derailing, i.e. trains entering on 
spur tracks automatically cause a switch throw to that spur.  Physics is not taken into account on 
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either grades, radius track, starting or stopping trains ( they won’t break in two or crash 
together).  RR-Track simulator does not trace track  through modules so modular layout 
operation is not supported.

If you make any changes to your layout in Plan View, all trains are immediately cleared from Simulation View 
since there current track may no longer exist.  You can easily re-set them on track by choosing them from the 
consist list.  For more thoughts on problems with legacy layouts, see Simulation View Operational Notes.

When you choose the Simulation View tab, RR-Track displays a window that looks like that above.   On the left 
is your layout shown in plan view, similar to the Plan View display.  At right is a panel that contains controls for 
starting/stopping the simulation, constructing a new train, and a train list window that lists all of the trains 
currently in the simulation.

Simulation Status Bar
At the far left is a start/stop 
button for the train operations 
simulator. Pressing this 
starts/stops the main simulation clock.  This is identical to pressing the Sim START/STOP buttons located at the 
upper right of the main Simulation View window.

Next is a button that lets you access the consist list.  Pressing this pops up a list of pre-
built train consists ( both stored and local ) that you can choose from to quickly add a 
ready-to-go train to the simulation.

Finally, at right is the Options button.  Pressing this brings up the Simulation View Options dialog allowing you to 
customize some aspects of Simulation view.

Simulation View Menus
Action menu

New Train: shows the New Train dialog where you put together a consist and then add a new train to the 
simulation.

Clear All Trains: removes all trains from the simulation.  You are asked to verify this.

Reset Sim Clock: resets the simulation clock to 0:00.00.

Print Sim View: invokes RR-Print so that you can print a screen display of the current simulation.

Edit Consists: displays the stored consist list so that you can remove items if you need to do so.

Options:  displays the Simulation Options dialog letting you set various parameters that govern the train 
operation simulation.

View menu

Re-render All: re-calculates the entire simulation overview, and then re-draws it.

In 2X: zoom in by a factor of 2.  This is the standard RR-Track zoom in command, more information on 
zooming in may be found here.

Out 2X: zoom out by a factor of two.

Home: restore the zoom factor to one and reset the origin so the entire layout simulation becomes 
visible.

Redraw: re-draws the simulation overview.

Window menu

Cascade: standard Windows MDI command that arranges all master layout windows in a cascade 
starting at the upper left.
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Help menu

Contents:  opens the RR-Track Help file to the Simulation View topic.

About Simulator: displays the information dialog for RR-Track Layout Simulation.

Shortcut menus ( invoked by right-clicking over the simulation)

General shortcut menu

Zoom in 2X,4X:  zoom in by a factor of 2 or 4.  This is the standard RR-Track zoom in command, more 
information on zooming in may be found here.

Zoom out 2X,4X:  zoom out by a factor of 2 or 4.

Zoom last:  return to the previous zoom level and viewport.

Home:  restore the zoom factor to one and reset the origin so the entire layout simulation becomes 
visible.

New train:  shows the New Train Builder dialog where you assemble a consist and then place it on the 
simulated layout.

Options:  displays the Simulation Options dialog letting you set various parameters that govern the train 
operation simulation.

Train specific shortcut menu

Make train live:  connect this train with a cab so you can move it.  If another train is live, you will be 
asked for confirmation.  See train operations for more information.

Flip train direction:  reverses the consist’s train unit order, exchanging back for front.

Store consist:  add this consist the list of permanent consists.  You will be asked for a name.  See train 
operations for more information.

Delete train:  removes the train from the simulation.

Train properties: displays the Train Properties dialog giving statistical and other information about the 
train under the cursor.

TU properties:  displays the Train Unit Properties dialog giving statistical and other information on the 
train unit under the cursor.

Module Compiler
The RR-Track Module Compiler takes a small layout design and compiles it into a module ( an monolithic item 
that can be treated as a complex piece of track).  In this manner you can create modular layouts by arranging 
and re-arranging these ‘custom’ track components.

Modules can contain any of the components that make up a standard RR-Track layout:  track, accessories, 
objects.   The Module Compiler lets you choose which track ends are available for joining to other modules, or 
other track.  

Modules take on the track compatibility profile of the first exposed end (i.e. if the first exposed track end is Lionel 
FasTrack, the entire module is considered a FasTrack compatible module; likewise for Atlas HO).  Internal to a 
module you can mix/match track manufacturers ( subject to RR-Track joining rules) as you would a normal 
layout, but externally all of the exposed track ends must be from the same manufacturer.

RR-Track module files ( extension .rrm) are stored in a folder called modules under the root folder of your RR-
Track My Layouts in your My Documents folder. 

Using Module Compiler
First, you have to create a layout which serves as the source for the module. Below is a 4 x 2 layout which we 
will use as a source for a module.  This layout conforms for the most part to NMRA Standard MS-1.0 for modular 
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layouts in O-scale.  

From Plan View, pull down the File menu and choose Create Module.  This brings 
up the Module Compiler window.  There are three main displays shown by Module 
Compiler.  At upper left is a listing of the available free track ends and their locations. 
At lower left is a listing of the module components broken down by track sections, 
accessories, terrain, and other items.  Dominating the Module Compiler display, at 

right, is a schematic plan view of the module. Green circles denote free track ends (those that will be exposed as 
junctions for other modules and track), and red denotes track ends too far from the edges to be considered 
usable.  Bright green denotes track ends that are open ( exposed ) and dark green those that are closed ( not 
exposed to the rest of the layout).

Since the spur track terminates with a bumper, there are no 
unusable track ends ( red circles ).  If you hover the cursor 
over one of the green circles it will change to indicate you 
are over a track end ( CP ).  If the cursor is grayed you will 
not be able to change whether the CP is open/closed ( it is 
not usable).  Clicking on usable track ends ( those that are 
some shade of green ) toggles them between open and 
closed ( bright green and dark green).  As you toggle the 
open/closed state of usable track ends, the free track end 
list at the upper left changes to reflect this.  Changing the 
exposure state of free track ends is the only editing you can 
do in Module Compiler ( if you want to change the 
arrangement of any of the items in the module you must return to Plan View by closing the Module Compiler 
window).  

To Create a Module
Pull down the Action menu and choose Build Module.  This brings up the 
Module Compiler Save dialog, like that at left.  You need to enter three sets 
of text:  module name, module description, and module author.  The 
module name is the moniker this module goes by on the Module List 
window and Component View.  The description tells you the general 
makeup of the module, and the author name is obvious.  Press Make 
Module when you are ready to add this to the module list, or Cancel to 
abort.

When you make a module, Module Compiler immediately adds it to the 
Module List, whose visibility is controlled by selecting the Show Modules 
command on the View menu when you are in Plan View.  

RR-Track then closes the Module Compiler.

All module compiler operations are initiated from Plan View.

To Add a Module to the Layout
• Pull down the View menu and choose Show Modules if the Module List window is not visible. 

• Choose one of your modules from the Module List.  RR-Track places that module under the cursor in the 
active layout window. 

• Move the module to where you want it, and click the left-button to snap it in place.   RR-Track positions 
and/or joins the module just as if it were a track section. 

For joining/unjoining purposes, RR-Track treats modules as if they were an ordinary track section.  You remove a 
module from a layout like you would any other item, by deleting it.

To Change the Name of a Module
• Pull down the View menu and choose Show Modules if the Module List window is not visible. 
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• Right-click on the entry whose description you want to change.  

• Choose  Edit Description from the shortcut menu. 

• Type in the new description in the top-most field of the Edit Module Description dialog. 

• Press the Change button to lock-in your new description, or press Cancel if you don’t want to change 
anything. 

You can view the relevant parameters of any of your modules by right-clicking its name on the Module List and 
choosing Show Properties.

To Remove a Module
• Pull down the View menu and choose Show Modules if the Module List window is not visible. 

• Right-click on the entry whose description you want to change.  

• Choose  Delete Module from the shortcut menu. 

• You will be asked to confirm this, deletes are final. 

RR-Track removes the module file from the modules folder and rebuilds the module list.  Deleting a module as 
no effect on modules that are already in layout files.  If you need to restore a module after deleting it, you must 
go back and open the original RR-Track source layout and choose Create Module from the File menu.

Module Compiler Menus
Action menu:

Build Module:  choose this command to take the layout shown in the Module Compiler plan view window 
and turn it into an RR-Track module.  You will be asked to provide a name, description and author.

Close Module Compiler:  terminates the Module Compiler and returns to RR-Track.

Window menu:

Cascade:  standard Windows Multiple Document Interface command to arrange all top-level windows in 
a cascade starting at the upper left.

Help menu:

Contents:  brings up RR-Track Help opened to the Module Compiler help topic.

Module specs...:  brings up a dialog displaying all of the current RR-Track Module definition files with 
their summary specifications.

About MComp:  shows the about dialog for the Module Compiler.

Printing with RR-Print
RR-Print is the coordination point for all printing in RR-Track.  Whether you are printing the 2D Plan View, a list 
of components from Component View, a screen shot from 3D View or Simulation View, all is funneled through 
RR-Print.

Each view handled by RR-Print can select its own output printer from the list of installed printers in Windows. 
The display in RR-Print, regardless of view, is an accurate preview of your layout’s appearance on the printing 
device you choose.

Menus for RR-Print
Print Selected Pages:  spools the selected pages to the current printer.  Same as pressing the  button

Print From Setup: displays the Printers Setup & Selection dialog.  Here you can choose a different 
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printer and change the page selection. 

Printer Setup:  displays the Printer Setup dialog.  Here you can change print settings and/or printers, but 
you cannot print.  Same as pressing the   button.

Page Setup:  displays the Page Setup dialog.  This lets you set margins and position the page headers. 

Close RR-Print:  dismisses the RR-Print utility and returns you to RR-Track. 

About:  displays the information dialog for RR-Print. 

Plan View Printing
When you choose to print one of your views, RR-Print starts and presents you with a view like one of these.  

First is the RR-Print utility for the 2D Plan View.  This is where you will do most of your printing, and there are 
options to specify the pages to print, the page offset from the layout origin, the page margins,.the layout scale 
and whether to use fixed or automatic scaling, and a set of options which control the appearance of the overlay 

coordinate grids, item labels, track 
features, terrain features, etc. 

On the left is a print preview window 
showing how your layout will look on the 
actual printer page in its current 
orientation and scale.  At upper right is a 
collection of five tabs that both display 
current print settings and let you access 
features and options of RR-Print.  These 
tabs are divided up into general, auto-
scale, fixed scale, printer, and options. 
There is a large button at lower right 
which lets you toggle between showing a 
page printing preview ( how your layout 
pages appear on the selected printer ) 
and a page layout overview ( how your 
layout pages tile your actual layout 
design ).  There is a Help button to take 

you to the RR-Print help topic and a Close RR-Print button to take you back to your master layout window.

Notes:  RR-Print will spool a maximum of 256 pages to your printer.  This limits the smallest 
scale factor that can be attained.  Any scale factors ( such as 1:1 ) that will produce more than 
256 pages are grayed out and not accessible.  You will either need to use a larger page size, or 
not print at that small a scale.

Page Preview Window
The Page Preview window consists of two distinct 
regions: a set of toolbar buttons, drop down lists, and 
page list controls along the top, and a window that 
displays how your RR-Track layout will print on the 
current printer. 

Using either the mouse pointer or the controls on the 
toolbar, you can zoom into any location on the page 
preview up to 1000 per cent. All of the toolbar controls 
have tooltips that will momentarily display the use of a 
control if you hover the mouse pointer over it.

Printing Toolbar
The Page Preview toolbar consists of a series of 
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controls that let you change the zoom, number of pages displayed, and quickly access printer setup and printing. 

From left to right, the first three controls let you set the zoom level of the page preview.  You can choose a zoom 
factor from the drop-down menu at left, or use the + and - buttons to zoom in and out.  If you position the cursor 
over the preview, left clicks zoom in and right clicks zoom out.

The function of the individual buttons is 
discussed in detail below.

Pressing the single page button toggles the page preview to show only a single page, setting the zoom 
accordingly.

Pressing the multiple pages button switches the preview to show more than one page.   Press the 
drop-down to  up to 12 pages at once, in a variety of formats ( 1x2, 2x2, 2x3, etc.)

You can set the current page by either typing in a page number or using the left/right spin 
buttons to navigate to the page you want.  You can also choose the current page by scrolling 

through them using the left/right arrow keys on the keyboard.

Pressing the printer setup button invokes the Printer Setup dialog for the current printer.  Here you can 
change things like the page orientation, printing quality, and change printers as well ( if you have more than 

one available printer).

Pressing the print current page button immediately spools the current 
page to the current printer.  This is the fastest way to get a print of your 

layout.

If you set a scale that causes your layout to span more than one full printer 
page, you can re-configure the page preview to show more than one page, up 
to a maximum of 12.  At right is a preview of four pages with the current page 
highlighted.  You can change the current page by either typing in a new value, 
using the page selection spin buttons, or using the left/right arrow keys on the 
keyboard.  The highlighted page is the one that will print if you press the print 
current page button.  You can zoom in on the current page by clicking on it 
with the left mouse button ( right clicking zooms out).

Page Layout Window
The page layout window shows an overview of how 
the current printer’s pages at the current scale and 
orientation will tile your layout.

Below the page layout window are a set of spin 
controls and readouts which let you position the 
printer page origin at an arbitrary location.  This is 
very useful for repositioning the tiling pattern to avoid 
awkward seams.

Press the L/R spin buttons to change the horizontal 
( x ) and vertical ( y ) offsets, press the Reset Offset 
button to return the printing offsets to zero.  RR-Print 
updates the page layout window dynamically as you 
change the offsets to reflect the new page locations.

Print Settings Tabs
All of the Plan View printing setting are contained in the five tabs located on the right side of the Plan View Print 
Preview.  

General Tab:  the general tab is informational only and displays current parameters relevant to the printing 
process. These include the printable page area, how this related to the actual layout at the current scale, the x-y 
offset ( relative to the layout coordinates ) of the printer page’s lower left corner, and then a summary of layout 
statistics.  No print settings are changed in this tab.
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Auto-scale tab:  the auto-scale tab is pretty simple.  There are two buttons, one doubles the scale each time 
you press it ( like zooming in by 2X ) and the other halves the scale each time your press is 
( like zooming out by 2X ).  In both cases the scale is determined automatically by matching 
the layout’s horizontal extent to the printable page width and the layout’s vertical extent to the 
printable page height ( these can be swapped if you toggle between portrait and landscape 
orientations ).   Any change you make in scale is reflected immediately in the print preview or 
layout preview window.  As you double or halve the scale, RR-Print displays the new scale 
and the total number of pages required to tile your layout. 

Note: It is important to remember that if you want to make maximal use of your 
printer page, you should match the longest side of the page to your layout’s longest 
extent.

Fixed-scale tab:  the fixed scale tab lets your choose from a number of pre-defined scales 
that determine the physical relationship between distances on your layout and those on the 
printer page, rather than letting RR-Print determine these for you.  

There are nine total scales to choose from:

• 1” = 20ft (1:240 ) 

• 1” = 10ft ( 1:120 ) 

• 3/16” = 1ft ( 1:64 ) 

• 1/4” = 1ft ( 1:48 ) 

• 1/2” = 1ft ( 1:24 ) 

• 3/4” = 1ft ( 1:16 ) 

• 1” = 12” ( 1:12 ) 

• 1” = 6” ( 1:6 ) 

• 1” = 1” ( 1:1 ) 

As for the auto-scale tab, changes you make on the fixed-scale tab are reflected immediately in either the page 
preview or page layout windows.  For each fixed scale you choose, RR-Print shows the total number of printer 
pages required to tile your layout, and the number in each row and column.

Of the fixed scales, the two that are the most useful for transferring measurements on your print to those on the 
physical layout are 1:12 and 1:16 ( architectural scale ).  If you use the architectural scale of 1:16, then 
measurements made using the 16s scale of a standard engineering ruler translate directly to inches.

Printer tab:  the printer tab is both informational and provides access to one of the most 
used printer settings, the page orientation.

RR-Print shows the name of the current printer, the physical paper size ( 8.5 x 11 say ), the 
printable page size ( the actual area the printer can use ), the printer resolution in DPI ( dots 
per inch ), and offset of the upper left margin from the physical page size ( this should be 
zero for a PDF printer as shown ), and the user printable page size ( this is the accessible 
printing area taking into account the top/bottom left/right margins which may be adjusted 
from page setup.

There is a button for quickly toggling between portrait ( vertical ) and landscape ( horizontal ) 
page orientations.  There is also a button that lets you make the current printer the default 
printer for RR-Print.

Any changes made to the page orientation are immediately reflected in the page preview or page layout 
windows.

Options tab:  the options tab is where you select which printing feature are or are not present.  Unlike the 
previous tabs, changes made here are not updated in the page preview window ( or the actual print ) until you 
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press the Apply Options button.  From top to bottom these are:

Show
Coordinates:  you can turn on/off both the coarse ( large scale grid ) and a 
secondary ( small scale grid ).  The default is to show the coarse grid and hide the 
secondary grid.  Both grid sizes are calculated automatically by RR-Print depending 
the the longest layout dimension on the printer page (i.e. the smaller the scale, the 
smaller the grids). 

Track junctions:  toggles whether you want track joining symbols displayed or not.

Item labels:  toggles whether you want to show item labels and where they should 
appear ( above, below, or centered).

Terrain features:  toggles whether to show terrain items ( layout bench units, 
contours ) or not.

Track in color:  toggles whether track should be drawn using the colors you have set ( the default ), or 
only in black.

Units:  lets you choose between English ( feet/inches ) and Metric units, independent of your layout 
settings.

Special
Control Panel printing:  in this mode, all track is drawn using the center-line only with a single bold line. 
If Track in color is checked, the track colors will be used.  No accessories or objects are drawn, but 
coordinate grid overlays are unless turned off.

Hide axes:  toggles the appearance of the outside X-Y axes and their labels.

Your must press the Apply Options button in order to make any of these changes appear on the page preview.

Component View Printing
A typical displace for RR-Print printing a Component View appears below.  RR-Print shows exactly the item list 
that you had open when you chose to print.  If you want 
certain, or all, items expanded, then you need to do that 
before  choosing to print ( expansion of items is only available 
in tab component, or layer views).  

Printing Toolbar
The Page Preview toolbar consists of a series of controls 
that let you change the zoom, number of pages displayed, 
and quickly access printer setup and printing.  

From left to right, the first three controls let you set the zoom 
level of the page preview.  You can choose a zoom factor from 
the drop-down menu at left, or use the + and - buttons to 
zoom in and out.  If you position the cursor over the preview, 
left clicks zoom in and right clicks zoom out.

The function of the individual buttons is discussed in detail 
below.

Pressing the single page button toggles the page preview to show only a single page, setting the zoom 
accordingly.

Pressing the multiple pages button switches the preview to show more than one page.   Press the 
drop-down to  up to 12 pages at once, in a variety of formats ( 1x2, 2x2, 2x3, etc.)

You can set the current page by either typing in a page number or using the left/right spin 
buttons to navigate to the page you want.  You can also choose the current page by scrolling 
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through them using the left/right arrow keys on the keyboard.

Pressing the printer setup button invokes the Printer Setup dialog for the current printer.  Here you can 
change things like the page orientation, printing quality, and change printers as well ( if you have more than 

one available printer).

Pressing the print current page button immediately spools the current page to the current printer.  This is 
the fastest way to get a print of your layout.

3D View Printing
A typical display for RR-Print printing a 3D View appears at 
left.  RR-Print shows a screen capture ( bitmap ) of your 3D 
rendering when you chose to print.  If you want a different 
orientation or magnification, you need to close RR-Print and 
return the 3D View and set those conditions.

The printing toolbar is identical to that for Plan View printing 
and Component View printing, see the previous explanation 
for these.  

Simulation View Printing
A typical display for RR-Print printing a Simulation View 
appears below.  RR-Print shows a screen capture ( bitmap ) 
of your layout simulation when you chose to print.  If you want 
a different zoom or train arrangement, you need to close RR-
Print and return the Simulation View and set those 
conditions.

The printing toolbar is identical to that for Plan View printing 
and Component View printing, see the previous explanation 
for these.  
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Essays on Standard RR-Track Operations
These are descriptions of some of the common things you do with RR-Track while working on a layout design. 
There are more topics than are contained here in the RR-Track v5 Help system that you access using the Help 
menu.

Selecting Items
Before you can do anything useful with track sections, accessories, or objects you have already placed in the 
layout, they must first be selected.  Items must be selected before they may be moved, copied, cut, deleted, 
rotated, joined, aligned, closed, and relaxed.

Track selection is an action performed almost entirely with the mouse cursor (the exceptions are the Select 
commands in the Edit menu), but is modified by the enabling/disabling of the extended selection mode ( 
Selections Include Joints, Selections Include Blocks, Selections Include Grades) on the Options menu and the 
status bar.

Extended selections occur when you double-click the left mouse button instead of single clicking.  The current 
extended selection mode is denoted by a check mark in front of it on the Options menu.  When the extended 
selection mode is set to Selections Include Joints, then all of the track physically joined to the track under the 
cursor will be highlighted when you make an extended selection.  When the extended selection mode is set to 
Selections Include Blocks, then all of the track sections electrically connected to the section under the cursor are 
highlighted.  This mode is very useful for checking the arrangement of electrical blocks on your layout.  When the 
extended selection mode is set to Selections Include Grades, all of the track that is either on the same grade or 
at the same elevation as the track under the cursor is highlighted.  This will let you quickly choose elevated track, 
and is helpful for some of the commands found under the Grades menu.

Among track in the selected track list, the first track section is called the lead 
selection.  This section is highlighted with larger control points than the 
secondary selections and bold lines.  The graphic above illustrates this. 
Note that the leftmost section has the large, filled squares denoting its control 
points.  Circles denote points that are joined, while hollow squares are 

unused control points.  The lead selection is the track section about which rotations occur, moves are referenced 
to, and which determines who is moved to whom when aligning or joining track and there is more than one 
possibility for movement.  The lead selection is drawn with bold lines, while the other track sections are drawn 
using a single width pen.

Selecting Items
You can select track and any other item in a layout in two distinctly different manners using the mouse pointer. 
The first way is to draw, or drag out a selection box around the items you want to select.  The second lets you 
select each object in turn, and is slower but more precise.

Selecting with a selection box

• With the Windows arrow cursor showing (i.e. you aren't in the middle of some other procedure), position 
the cursor in an area where there are no items, and you wish to start the selection rectangle. 

• Depress and hold the left mouse button.  The cursor changes to   indicating that you can now begin to 
sweep out a selection rectangle. 

• While continuing to hold down the left mouse button, sweep out a rectangle containing the objects you 
wish to select.  It will be drawn as you move the cursor using dashed blue lines.  The items you want to 
select must be located entirely within the selection rectangle for RR-Track to choose them (actually their 
bounding boxes have to be located in the selection rectangle and this can be somewhat bigger than the 
track sections, especially for sharp curves and turnouts). 

• When you are satisfied with the selection rectangle you have drawn, release the left mouse button.  All 
track and other objects within this region are placed into the select list and highlighted.  The cursor 
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returns to the Windows arrow. 

Using this method, the lead selection will be the first track section found in the item list that is in the selection 
rectangle (RR-Track scans the item list from back to front, that is most recently added to least recently added). 
Be aware that using the selection box does not select track that is not in the box, regardless of the setting of the 
extended selection mode, i.e. there are no extended selections when using a selection box.  You can further fine 
tune the selections by individually selecting/deselecting items using the SHIFT-left mouse combination as 
described below.

Selecting items with the mouse pointer

• With the Windows arrow cursor showing (i.e. you aren't in the middle of some other procedure), position 
the cursor over the track section or object you wish to select and single-click the left mouse button.  RR-
Track highlights the item in red. 

• To add objects or track sections to the select list, position the cursor in turn over the next objects and, 
while holding down the SHIFT-key, single-click the left mouse button.  The new object is highlighted.  If 
this item was already selected (highlighted) it will be deselected instead. 

• Repeat step 2 until you have selected all the track or objects you need. 

 

 Hint:  you may both select and move at item in one operation by placing the cursor over that 
item, then depress and hold down the left mouse button for 1/4 to 1/2 second.  RR-Track will 
assume you want to move the object(s) under the cursor, highlight them and then change to the 
cursor .  In this manner you do not need two separate mouse clicks to initiate moving an object

 Note:  you can use the left mouse click combined with the SHIFT-key to fine-tune a group of 
selections made using a selection rectangle.  Just choose the items initially by sweeping out a 
selection rectangle with the mouse pointer, and then add or subtract additional items as needed 
to pare the select list to just the items you need..

Making Extended Selections
To make an extended selection, you double-click the left mouse button when over the first track section you want 
to select.  Depending on which extended selection mode is currently set (Joints, Blocks, or Grades), RR-Track 
will choose the track section under the cursor and all of the others joined to it, modified by the extended selection 
mode (the track section under the mouse pointer becomes the lead selection).  If more than one track section is 
currently highlighted, and the left mouse button is double-clicked, RR-Track collapses the selected track to only 
that track section under the cursor, regardless of whether the multiple selections occurred because of a previous 
double-click or not.  In other words, to return multiple selections to only the track under the pointer you can 
double-click when over this section rather than manually deselecting track items using the SHIFT-left mouse 
combination.  Identical to single-clicking the left mouse to make a selection, double-clicking and holding down 
the left mouse button after the second click will cause RR-Track to change to the    cursor after 1/4 to 1/2 second 
(this delay time is user settable with the Global Options dialog).  In this manner, a single double-click allows you 
to select a chunk of track and then move it to a new location. 

Changing the Lead Selection
In order to change the lead selection of track that has already been selected, position the cursor over the track 
section you wish to become the lead selection and single-click the left mouse button.  In this manner if you need 
to change the center of rotation, you can do so without having the de-select and re-select items..

De-selecting Items
To deselect items, position the mouse pointer over the already selected item (it will change to indicate you are 
over something) and, while holding down the SHIFT-key, single-click the left mouse button.  The item is removed 
from the select list, and highlights disappear.  To deselect all of the items, simply move the cursor to an empty 
area of the layout and single-click the left mouse button.  You may also de-select all items by pulling down the 
Edit menu and choosing De-select All.
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Selecting using the Edit Menu
There are three Select commands under the Edit menu which can be used to select large groups of items 
without using the mouse pointer.  These are Select All, Select All In Layer, and Select All Visible.  Items 
selected using these commands can be manipulates just as if you had individually selected them using the 
mouse pointer.

Select All:  this command selects all of the items in a layout, regardless of visibility or layer, except 
terrain objects in the Terrain Layer.  If you want to remove everything and start over, this is a good way to 
start. 

Select All In Layer:  this command lets you select all of the items in any layer except the Terrain Layer. 
RR-Track shows the Select Layer dialog when you choose this command.  Use this dialog to choose the 
layer, and then press OK.  All of the items in the layer are selected and highlighted. 

Select All Visible.  This command selects all of the items in the layout that are in layers that are either 
working, active, or inactive (see working with layers for more information on layers).  Another good way 
to clear out a lot of stuff at once. 

Selecting Using the Display List dialog
You can also select and highlight items singly ( for removal from the layout ) using the Select List dialog.  You 
can bring this dialog up by choosing the Show Display List command under the View menu.

Changing the Zoom and Moving the View
There are four zoom commands on the View menu which let you change the magnification, or zoom factor on 
your layout plan view.  These are Zoom In 2X, Zoom Out 2X, Zoom in 4X and Zoom Out 4X.  You can also 
change both the zoom factor and view location by selecting the Home View, Fit in Window, and Last View 
commands.  

To Zoom in by 2 or 4
• Pull down the View menu and choose Zoom in 2X (or 4X if you want to move in further).  The cursor 

changes to a square with four inward point arrows, and a zoom box representing a 2x or 4x 
magnification surrounds the cursor. 

• Move the cursor around the layout until you are satisfied with the location of the zoom box. 

• Press the left mouse button.  The portion of the track layout inside the zoom box is magnified until it fills 
the screen, representing a zoom in of 2 or 4 depending on whether you chose 2X or 4X.  The zoom 
factor in the status window updates reflecting the new magnification.  The cursor returns the standard 
Windows arrow. 

You can zoom in to a maximum magnification of 64X.  You may also access the zoom commands from a 
shortcut menu.

To Zoom out by 2 or 4
• Pull down the View menu and choose Zoom Out 2X (or 4X if you really want to move out).  The center 

of the old view becomes the center of the new view, with the magnification reduced by 2 or 4 
respectively. 

To View the Entire Layout
Pull down the View menu and choose Home View or Fit in Window.  These commands are similar, but have 
different actions if the layout window has been resized at any time.  Home View goes to a zoom of 1 and sets up 
upper left corner of the layout to the upper left corner of the window.  Fit in Window does the same, but also 
adjusts the scale to make maximal use of the layout window area.

Panning and Scrolling Around the Layout
You may move the current view around your layout using either the mouse, the keyboard, or the Overview 
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WIndow.  When using the keyboard, the arrow keys (usually found in a cluster near the lower right) are used by 
RR-Track to get the panning or scrolling direction.

To pan or scroll using the keyboard:
• Without pressing any other keys, press the left or right arrow keys to pan left and right, and press the up 

or down arrow keys to move up or down.  Each time you press a key, RR-Track moves 10 per cent of 
the layout extent in that direction 

• When you are located where you wish to be, stopping pressing the arrow keys. 

RR-Track will not let you pan or scroll more than 25 per cent of the layouts extent over the edge in any direction. 
For more information on this and other keyboard shortcuts, see keyboard shortcuts.

To pan or scroll using the mouse cursor:
• Move the cursor to the layout edge in the direction you wish to pan or scroll (i.e. move to the left edge to 

go left, top edge to go up, etc.) 

• When you near the edge, the cursor changes to either Scroll or Pan with an arrow appropriate for that 
edge. 

• Left click the mouse.  RR-Track pans/scrolls the layout view 10 per cent of the layout extent in the 
respective direction.  You cannot scroll or pan more than 25 per cent of the layout window extent beyond 
the edge of the layout. 

• Repeat step 3 as many times as required. 

To move the view using the Overview Window
• Move the cursor to the Overview Window. 

• Position it over the red-bordered rectangle ( there won’t be a rectangle if you are zoomed out to view 
then entire layout ).  The cursor changes to a + when you are over the current view ( as denoted by the 
rectangle ). 

• Depress the left-mouse button.  The cursor changes to a hand.  While holding the left-button down, drag 
the rectangle to where you want the view. 

• Release the left-button.  RR-Track draws the Plan View in the new location. 

You may also pan/scroll the view when the cursor is over the Plan View by using the mouse wheel.   Rolling the 
wheel causes the view to move up or down, rolling the wheel while holding the SHIFT key down causes the view 
to pan left/right. 

Working with Grades
RR-Track allows you to change the elevation (height) of a section or sections of track so you can create layout 
designs using track locations that vary up and down as well as horizontally..

RR-Track distinguishes track that is not at zero height (flat on the table or ground) as one of two types;  elevated 
track or grade track.  Elevated track are those sections, which are contiguous, that are all at the same height. 
Grade track are those sections, on one or more sides of an elevated track, that have both non-zero height and a 
non-zero slope (i.e. the track sections one either side are at different elevations).  Grade track is denoted by a 
small arrow symbol at the center which points in the direction of increasing elevation.

You can use two commands, both under the Grades menu, to change the height of track;  Set Track Height or 
Zero Track Height.  Choose Set Track Height to set a non-zero height (either above or below the the terrain 
base) or Zero Track Height to return the selected track sections to zero, i.e. flat on the terrain base.

Simple things first:
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To set the track height to zero:
• Select   the track whose height you wish to return to zero. 

• Pull down the Grades menu and choose Zero Track Height.  All of the selected track's height is set to 
zero.  Any grades connected to the newly zeroed track are automatically recalculated. 

To set the track to a non-zero height:
• Select   the track whose height you want to set. 

• Pull down the Grades menu and choose Set Track Height.  RR-Track shows the Set Track Height  
dialog;  use this dialog to designate the height you want to use.  Press OK to set the new height, or 
Cancel to revert to the old height. 

Hint:  you can choose all of the track at a given height or on a given grade by setting the extended 
selecting mode to Selections Include Grades and double-clicking with the left mouse button when over 
one of the track sections at that elevation.

You can also create track on grades.  Grade track connects track at one elevation with track at another.  Each 
track section on a grade is at a different which RR-Track interpolates to smoothly take the track height from that 
on one side to that on the other side.  RR-
Track does not restrict the steepness of the 
grade you create, that is for you to decide 
(see a word on grades for a discussion on 
the tradeoffs with grades).  In order to 
create a grade, there must be track 
connected to each end of the prospective 
grade track that are at different heights, 
like that shown above.

Here we have 9 sections of track that 
connect sections of straight track at zero 
height at the right to a single section at a 
height of 5 inches on the left.  We would 
not be able to turn this into a grade if we 
had also selected either of the end track 
sections.  You set a grade by selecting the 
track you want to use on the slope, and 
then choosing the Create Grade command.

To add to a grade
• Select   all of the track on the grade you want to increase in length. 

• Using the SHIFT key in conjunction with the left mouse button, select additional track sections on one or 
both sides to add to the existing grade (all of the sections must be contiguous); 

• Pull down the Grades menu and choose Create Grade.  RR-Track takes the old grade, adds the new 
sections to it, and recalculates all of the intermediate heights. 

To subtract from a grade:
• Select   the track section(s) at either end of the grade that you want to remove from the grade. 

• Pull down the Grades menu and choose Set Track Height.  RR-Track shows the Set Track Height  
dialog. Using this dialog, set the new track height, usually to that of the track section that terminates the 
grade.  Press Set Height.  RR-Track sets the selected track to the new height, and immediately 
recalculates any and all of the connecting grades. 

Below shows the grade example rendered in 3D. Note the flat lead-in straight sections on both ends.  With a 5.0 
inch height change, this grade is 5.4 per cent, steep by anyone’s standards. 
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A Word on Grades
Almost everyone who envisions a dream layout has a mental image of trains cruising around sweeping curves, 
up and down hills, intertwining and crossing over each other.  The reality of creating this kind of a layout is 
daunting;  in order for the trains to look good and run well curves should be large and grades should not be 
steep.  Both of these requirements translate into a lot of real estate.  Consider that real railroads view a one per 
cent grade as steep, and that a standard Lionel trestle set is about a 7.5 per cent grade.  When a train goes up a 
grade, it must do extra work as it has to raise itself up against the earth's gravity; this means a greater load on 
the locomotive and a reduction in the maximum train length.  If you don't think that a 7.5 per cent grade sounds 
steep (this means a one inch rise for every 13.33 inches traveled) try taking a bicycle up a 7.5 per cent grade --- 
you will quickly be convinced of the work required ( watch the Tour de France when they are in the Alps).  There 
is also more strain on the couplers between cars, especially on the coupler between the locomotive and the first 
revenue car since all of the load of the cars on the grade is on this coupler --- which can lead to nasty 
uncouplings during operation..

Note:  Grades are expressed in terms of a per cent.  Mathematically, this is the tangent of the grade 
angle multiplied by 100.  In more practical terms, the grade percentage expresses the amount the track 
rises up (or sinks down) in a given distance.  For example, a 10 per cent grade (way too steep) rises 1 
inch for every 10 inches of horizontal run.  A one per cent grade rises 1 inch for every 100 inches ( 8 and 
1/3 feet) of horizontal run.  O-gauge trains require around a 6 inch clearance to pass over each other 
( 5.5 according to the NMRA) --- this means using a one per cent grade you would need a horizontal run 
of 600 inches ( 50 feet) to pass over another O-gauge train.  For HO these dimensions may be halved 
giving a 25 foot run (remember to include track support structure when calculating the height change you 
need).  To further examine the interplay between grade length, grade rise, and per cent grade, pull down 
the Grades menu and choose Calculator.

Train layouts may be roughly divided into two types:  a toy train layout (colorful operating accessories, no real 
concern for scale sizes), and a model railroad ( more or less realistic train operation, concern for scale sizes). 

Toy Train Layouts:  If you are designing a toy train layout, then you may not be concerned with the steep grade 
due to a standardized trestle set.  Typical grades can be in the four to five per cent range.  You have to be 
careful on the throttle when going up (and more importantly coming down since electric trains have no brakes) 
and the number of cars in your consist will be limited by the steep grades (the steeper the grade, the more 
traction your locomotive needs to pull the train up the hill).  Toy train layouts usually operate trains with short 
consists (three or four cars).

Model Railroads:  If you are designing a model railroad you need to restrict yourself to grades of 2 or at most, 
2.5, per cent.  This is double what a real railroad uses, but is still not too steep for the purpose of realism in both 
looks and operation.  The primary impact of this maximum grade restriction on layout design is the amount of 
space that must be allocated for the grade track.  A 2 per cent grade means the track must have a horizontal run 
of 50 inches for each 1 inch rise in height.  For a 6 inch height change (for O-gauge) you must have a run of 300 
inches (25 feet) in order to keep the grade at 2 per cent.  In some cases you can reduce this by having the lower 
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track go down while the upper track goes up splitting the height change between them.

When setting aside real estate for grade track, you can utilize curves at layout corners in order to conserve 
space.  Bear in mind that trains on curves, especially long wheel base steamers, encounter extra friction 
between the wheels and the rails which increases the load on the locomotive (you can observe  this yourself by 
setting a constant voltage on a locomotive and watching it slow down when going through sharp curves and 
speeding up on straight sections).  Both the increased friction in the curve and the work of pulling the train up the 
grade add together to increase the load on the locomotive.  For O-gauge this means you should try to restrict 
curves on a grade to O72 or larger (curves are measured by diameter in O-gauge, not radius) and for HO R-18 
or larger.

From an operational standpoint, having a lot of grades (or having a lot of sharp curves) means you have to be on 
the throttle to keep the train moving at a steady pace (this may be somewhat mitigated with the newer 
locomotives with speed control electronics, but is an issue for all older trains, some of which are not too old). 
Where possible, a simpler solution is to have more than one level of track on independent loops.  In this manner 
you can get the visual interaction of the trains without the headaches of deciding where to stash the grades and 
how to regulate the operation.

Measuring Distances
Often it is useful and even crucial to know the distances between objects and track sections on the layout in 
order to correctly space switch yards, unloading docks, or find out what length of track you need to fill a gap. 
Distances are simply measured using the ruler function in RR-Track.

There are two distinct classes of measuring distances ( or using the ruler function ) in RR-Track:  measuring 
between arbitrary points, or measuring between either track ends or object edit points.  Measuring between track 
ends is further subdivided into resolving the distances in the layout coordinate system ( x-y values correspond to 
the horizontal/vertical directions on the screen) or resolved in the source track end coordinate system ( x values 
are along a tangent line starting at the track end and y-value correspond to departures above or below this 
tangent line).

There are also two different methods for carrying out the process of designating the beginning and ending 
points.  The first method makes use of ruler commands found on the general purpose shortcut menu and the 
left-mouse button.  The second method makes use of the right-mouse button and the keyboard.  Either may be 
used; the second method is included for compatibility purposes with previous releases of RR-Track.

Measuring Between Arbitrary Points
Left-mouse method:

• Right click over nothing bringing up the general purpose shortcut menu. 

• Choose Measure Gen.  The cursor changes to the ruler cursor. 

• Place the ruler hotspot where you want start the measurement and depress and hold the left-mouse 
button. 

• While holding the left-mouse button down, drag the ruler hotspot to where you want to terminate the 
measurement.  RR-Track draws a line showing the distance measured. 

• Release the left-mouse button.  RR-Track displays the measurement results in the upper right corner of 
the layout window.  Click Done when you are finished reviewing them. 

Right-mouse method:

• With the cursor showing the Windows arrow (i.e. you aren't in the middle of some other operation such 
as drawing an object), place the tip of the arrow where you wish to anchor one end of the distance line. 

• While holding down the SHIFT-key, depress and hold the right mouse button.  The cursor changes to the 
ruler cursor. 

• Still holding the SHIFT and right mouse buttons, drag the ruler hotspot to where you wish to end the 
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measurement.  RR-Track draws a line showing the distance that will be measured. 

• Release the SHIFT-key and right mouse button. RR-Track displays the measurement results in the 
upper right corner of the layout window.  Click Done when you are finished reviewing them. 

In either case, the measurement results show the X-Y components and the total distance, as well as the angle 
with respect to the layout coordinate system.  If the current track library has capability for cutting or bending 
track, these measurements will be passed to it if you choose one of the further options for creating custom track 
sections. Otherwise, press Done to end the measurement display.

Measuring Between Track Ends
Left-mouse method:

• Right click over nothing bringing up the general purpose shortcut menu. 

• Choose Measure Track.  The cursor changes to the ruler cursor.  If you want distances resolved in the 
track end coordinate system, choose Measure Trk-Crd instead. 

• Place the ruler hotspot where you want start the measurement and depress and hold the left-mouse 
button. 

• While holding the left-mouse button down, drag the ruler hotspot to where you want to terminate the 
measurement.  RR-Track draws a line showing the distance measured. 

• Release the left-mouse button.  RR-Track displays the measurement results in the upper right corner of 
the layout window.  Click Done when you are finished reviewing them. 

Right-mouse method:

• With the cursor showing the Windows arrow (i.e. you aren't in the middle of some other operation such 
as drawing an object), place the tip of the arrow where you wish to anchor one end of the distance line. 

• While holding down the ALT-key, depress and hold the right mouse button.  The cursor changes to the 
ruler cursor. 

• Still holding the ALT and right mouse buttons, drag the ruler hotspot to where you wish to end the 
measurement.  RR-Track draws a line showing the distance that will be measured. 

• Release the right-mouse button and then the ALT-key. RR-Track displays the measurement results in the 
upper right corner of the layout window.  Click Done when you are finished reviewing them. 

In both of these cases, the measurements are resolved in the coordinates of the layout.   Much of the time, when 
measuring between track ends, it is more useful to have the distances resolved in terms of the track end tangent. 
You can do this for the right-mouse method by holding down the CONTROL key rather than the ALT key.  For the 
left-mouse method, just choose Measure Trk-Crd from the shortcut menu.

When you snap a measurement between track ends, RR-Track checks to see if the track ends form a gap ( i.e. 
they are not connected to each other through existing track).  If this is the case, and the working track library 
contains support for TrackWizard, the measurement results contains additional buttons that tell TrackWizard how 
you would like it to try and fill the gap.  For more information see the essay on using TrackWizard.

Measuring Between Objects
Left-mouse method (only supported method)

• Right-click over nothing to bring up the general purpose shortcut menu. 

• Choose Measure Obj.  The cursor changes to the ruler cursor. 

• Place the ruler hotspot where you want start the measurement and depress and hold the left-mouse 
button.  RR-Track snaps the start point to the nearest object edit point, regardless of its location. 

• While holding the left-mouse button down, drag the ruler hotspot to where you want to terminate the 
measurement.  
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• Release the left mouse button. RR-Track snaps the measure end point to the nearest object point, draws 
a line showing the distance measured and displays the measurement results in the upper right corner of 
the layout window.  Click Done when our are finished reviewing the measurement results. 

Measuring between objects is functionally the same as measuring between track ends, the difference is the snap 
points are the nearest object edit handles rather than track junctions.

Using TrackWizard
RR-Track has wizards in libraries that support flexible or cut track that can automatically fill in gaps in track plans 
for you.

Sometimes it is difficult to see how to join up two track ends, and you get involved with a lot of trial and error 
cutting and bending of track.  RR-Track has 'wizards' in many of the track libraries which can automate this 
process, and at least provide you with a starting basis for track selection.  TrackWizard may be configured on a 
library-by-library basis, see track wizard setup for more information.

Using the track wizards in RR-Track is very simple, all you have to do is make a measurement between the track 
ends you want to join up.  Below we have a typical situation, two track ends that we need to join with some 
combination of straight and curved track.

We are using Ross Custom Switches O-gauge track for our 
example, but we could use any manufacturers track that 
allows cutting and has flexible track.  Snap a ruler 
measurement between the track ends (see the essay on 
measuring distances for instructions on doing this). 
Performing this task with the track situation above 
generates a dialog, in the 

upper right corner of your layout window,  like that at right.

Here we have a distance measurement of 36.05 inches horizontally, 3.60 inches 
vertically, and 36.23 inches diagonally.  Although it is not shown, there is also an 
angular difference of 15° between the track ends.  If all we want to know is the 
distance between the ends, we can push the Done button and dismiss the 
dialog.  We summon the RCS O track library TrackWizard by pushing one of the 
buttons in the Custom Track group.  We don't want to cut a straight track section 
since that won't work, and it is unlikely that a standard cut sectional curved track 
will work.  Rather than worry about this, we push the stock track button (this gives us a pieces of custom 
configured straight and curved track ) and let TrackWizard figure this out.

Doing so results in a track configuration like that at right. 
TrackWizard put in the largest radius curve that would fit. 
This required a lead-in fitter straight section 14.2 inches in 
length mated to a O128 curve with a 15° arc, followed by a 
5.5 inch exit fitter straight section.  This was just one of 
several ways we could have filled the gap since we could 
obviously have used a smaller radius curve as well.

Fill Types
Since the Ross Custom Switches library has both sectional track that you can cut to smaller length, and flexible 
track that you can use to create your own custom curves, all of the standard wizard choices are available. 
These are <stock track>, <radius curve>, and <general curve>.  Pressing any of these buttons invokes 
TrackWizard and tells it to use the type or style of track that corresponds to the command button.

stock track This instructs TrackWizard to use stock straight and curved sections, cutting them as 
necessary.  This restricts the choices for curve radii to those offered in the track library (for GarGraves 
this is O-32, O-42, O-54, O-63, O-72, O-80, O-89, O-96, O-106, and O-138).  The wizard will assemble 
the required pieces of track in the correct order and insert them into the layout at the correct location 
between the track ends used for measurement.  The <stock track> command can also fill in straight 
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track between track ends that are in alignment, with a maximum offset error of 1/4 track width.

radius curve This instructs TrackWizard to use flexible track to create the required constant radius curve 
and straight fitter sections to fill in the gap between the measurement track ends.  The difference 
between choosing  <radius curve> and <stock track> is that any track radius can be used, not just those 
provided by the stock track in the library.  Like the <stock track> command, the <radius curve> command 
can also fill in straight track between track ends that are in alignment.

general curve A general curve is a curve of continuously varying radius that takes a track section from a 
location with a given starting radius of curvature, and brings it to another location with a given ending 
radius of curvature (the starting and ending radius of curvatures may be the same).  A general curve is 
the 'smoothest' fit between the two endpoints since it automatically eases the curve.  It is also the 
hardest curve to recreate by the builder of the layout.  Remember, there is small profit in being able to 
calculate and design something that you cannot easily build.  You can also select from three types of 
general curves using the Setup... command on the Track menu.  These three types are 

• (1) straight plus radius curve, 

• (2) straight plus opposed cubic easements, and 

• (3) continuous curve.  In all three cases the general curve is a piece of flexible track which you 
can later edit with the mouse pointer. 

We can return to the above track gap filling problem and 
change our choice of filling method.  This time we choose 
<radius curve>, this gives the results at right.  Here we 
have a single fitter straight section ( the lead-in , 8.7 
inches ) and a custom curve with a radius of 105.7 inches 
and an arc of 15°.  Of course you have to make this curve 
yourself from a piece of flexible track; in the previous 
example using stock track sections you only had to cut up 
an O-128 curve.

Finally, we can fill the gap by using a single flexible track section, with varying radius, 
rather than using two or three separate track sections.  We get this by choosing 
<general curve> as our filling method.  This gives the results at right, a single track 
section with a minimum radius of R-74.7 and a length of 36.5 inches.  You can further 
increase this radius by smoothing the flexible track ( smooth command after right-
clicking) to get a result closer to R-100.  The centerline points may be accessed by 
right-clicking on the flexible track section and choosing Properties from the shortcut  
menu.  Clicking on the Details tab shows something like that at left.  The entire list of 
centerline points may be copied to the clipboard so that you can print them out for the 
purpose of making a guide to use for forming the track section.

TrackWizard Setup
Many of the RR-Track libraries that have a TrackWizard allow you to 
specify a number of parameters that may be used to restrict the wizard 
's choices of track.  These may be accessed by pulling down the Track 
menu and choosing Setup...

When you do this, you will see a dialog like that at right.  There are three 
separate sets of parameters accessed by clicking on the appropriate 
tab:  general, flex track, and stock track.  

General Tab

Track Lengths:  here you can specify the minimum and maximum 
lengths used for cut-to-fit straight track.  The minimum you can type in, 
the maximum you select from the radio button choices in the 'for fill use' 
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section just below ( in the case of the Atlas track library in the example you have a choice between using 10 inch 
or 40 inch straight sections, so the maximum cut track length is correspondingly 10 or 40 inches).  

Track curves:  here you can specify the minimum radius used for custom radius fill sections ( the default is the 
minimum radius stock track curve) and the maximum arc angle allowed for any given custom radius curve 
section ( the default is just over 60°).

Flex Track tab

Pressing the flex track tab shows a set of controls like that at right. 
There are controls for specifying the minimum radius ( again, default is 
the smallest radius stock curve), the maximum length ( default is 
double the length of a standard piece of flexible track), and the type of 
curve used.

Continuous:  this is the most general style of curve.  The radius of 
curvature varies continuously with the track end points matching the 
angle and curvature of the track being joined at either end.

Radius curve:  this is the least general style of curve.  The radius of curvature is constant ( like a stock curve ) 
and incorporates a filler straight section at one end which is part of the flex track section.

Cubic-continuous:  this is a hybrid curve where each end of the interpolated curve is modeled on a cubic 
polynomial ( like for an easement curve ) with the curvature at each end of the flex track section zero.  This is 
best for smoothly matching up with straight track on either side of the gap you are filling.

Stock Track tab

Pressing the stock track tab shows a set of controls like that at right. 
You have a list of the available stock track sections on the left and a list 
of those that track wizard can use for filling on the right.  The default is 
all of the available stock curves.  

To Add A Curve to the Working Set:  highlight the curve in the left-
pane and then click the >> button.

To Remove a Curve from the Working Set:  highlight the curve in the 
right-pane and click the X button.

To Add All Curves to the Working Set:  press the +All button.

To Remove All Curves from the Working Set:  press the Clear button.  

Example:  if you don't want TrackWizard to use curves smaller than O72, highlight each of the O27, O36, O45, 
O54, O63 curves in turn and press the X button.

Press the OK button to save your changes, or Cancel to exit without changing anything.

Working With Layers
Layers are a feature of RR-Track which allow you to create very complex layouts without necessarily having to 
be aware of the complexity at all times.  A layer is simply a grouping of track and objects which have some 

common feature (such as they are all on the ground level, or they 
are all on the upper level, or they are all on the inner loop, etc.) 

Layers are nothing more than a way to help organize a complex 
layout, and most layouts get complex after a while.  A layer has 
assignable attributes which govern its visibility, selectability, and 
color.  For example, a train layout with two levels of track can, at the 
very least, have two layers --- the layer that has the lower level of 
track and that which has the upper level ( you can further divide this 
into a layer for the transition track as well).  In this manner you can 
hide the upper level while you work on the lower level, and vice 
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versa.

Every layout you create automatically sets up one layer for itself which it names <default layer>.  This <default 
layer> can neither be renamed or removed in order to safeguard you against accidentally creating a layout with 
no layers.  Making a layout with only a <default layer> is the equivalent of previous releases of RR-Track which 
used only one drawing layer.  When you create a new layout, the <default layer> is set as the working layer, i.e. 
the layer in which items are added.  Layers that you subsequently add can have any name you like, up to 48 
characters in length.  You should choose names that have significance for you.

When you create a new layout, you have the option to create a standard layout as opposed to a plain layout.  A 
standard layout sets up a layout with a number of pre-defined layers for track, bench work, wiring, scenery, etc. 
These may be renamed or removed as required, just like any other layer.  You can also add your own layers if 
you like.  A plain layout, in contrast, has only the <default layer>.  

To add a layer, modify a layer, or remove a layer from a layout, pull down the Options menu and choose 
Layers... (you can also double-click on the working layer pane in the status bar).  You will see the Drawing Layer 
Setup dialog like that above:

The data sheet pane shows the typical set of layers when you create a standard layout.  There are three track 
layers, two wiring layers, a scenery, buildings, bench work, and labels layer.  If you decide to rename some of 
these layers, be aware that the layer named bench work is somewhat special;  3-D Viewer will search for this 
layer if you choose to display in skeleton mode in 3-D.

You can change the sorting of the layers by clicking on the Vis header or the Layer header.  Clicking on Vis sorts 
the layers by visibility, with the working layer first, followed by active layers, inactive layers, grayed layers, and 
hidden layers.  Clicking on the Layer header sorts the layers alphabetically by name.  RR-Track shows the 
working layer as a <W> ( in red), active layers as a -a-, inactive layers with -i-, grayed layers with -g-, and hidden 
layers with -h-.

The attributes of the currently selected layer are shown in the Layer Attributes radio button group to the left of the 
data sheet pane.  There are four command buttons for modifying layers:  Add (to add a new layer), Remove (to 
remove the selected layer), Rename (to change the layer name), and Change (to execute an attribute change). 
Overall layer drawing and fill colors may be set using the drop down lists in the Layer Colors group.  The layer 
color overrides the drawing color set for a given library, however, a color set for an individual track section will 
override the layer color.

Layer Attributes
A layer can have one of five attributes (listed in decreasing order of activity): working, active, inactive, grayed, 
and hidden.

The working layer is the layer that items are added to when you add track, accessories, or objects to 
your layout; there can be only one working layer.  You can select items in the working layer, move them, 
join them, unjoin them, rotate them, and delete them.  Obviously, the working layer is visible.  

An active layer is the same as a working layer, except that items are not added to an active layer, only 
to the working layer.  As for the working layer, items in an active layer can be selected, moved, joined, 
unjoined, rotated, and deleted.  Any number of layers can be active layers; active layers are visible.  

An inactive layer is visible, just as for the working and active layers, but items in inactive layers cannot 
be selected (the are invisible to the mouse), and hence cannot be manipulated (until you change the 
layer attributes).  Inactive layers are similar to Windows wallpaper; you can seem them but you can't 
touch them.  A good use for inactive layers is for bench work while you are working on the track.  

Grayed layers are like inactive layers but items in grayed layers are drawn using a pale gray pen; 
objects and accessories are only drawn in rough outline form.  Grayed layers are useful when you need 
to see underlying items for the purpose of registration with other items, but you don't want to be plagued 
with all of the details.  

Hidden layers are just that; they are not visible at all.  Hidden layers are useful when you don't want the 
details of upper level track to bother you while you are working on the lower level.  They are also useful 
for storing items if you are partial to the palette method of layout design.
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The table below summarizes the properties of the various types of layers:

Attribute Visible Selectable Addition

working Y Y Y

active Y Y N

inactive Y N N

grayed partial N N

hidden N N N

If you are adding a new layer, removing an existing layer, or modifying the attributes of an existing layer, you will 
use the controls in the Layer Attributes section of the Drawing Layer Setup dialog.  The Change button is only 
enabled when one of the attributes radio buttons is clicked.

The following actions are frequently executed using the Layer Attributes control group.

To Add a Layer
• Pull down the Options menu and choose Layers...  RR-Track shows the Drawing Layer Setup dialog. 

• Press the Add button.  RR-Track shows the New Layer Name dialog. 

• Type the name for the new layer in the dialog and press OK (press Cancel to abort adding a new layer). 
RR-Track creates the new layer with the name you specified and sets its visibility attribute to inactive. 
No drawing or fill colors are assigned at this time. 

• You can assign non-default dawing/fill colors, and you can set the layer’s visibility attributes by using the 
drop-down color choosers and checking the appropriate radio button. 

• Press OK to dismiss the Drawing Layer Setup dialog. 

You can change the new layer's attributes and colors to whatever you want using the attributes radio buttons and 
the colors drop down lists.

To Remove a Layer
• Pull down the Options menu and choose Layers...  RR-Track shows the Drawing Layer Setup dialog. 

• Select   the layer you want to remove by clicking on it with the left mouse button on the layer data sheet. 

• Press Remove.  If the layer contains no items, RR-Track immediately removes it.  If the layer is 
occupied, then RR-Track tells you this and aborts removing the layer. 

• Press OK to dismiss the Drawing Layer Setup dialog. 

You can only remove layers that contain no items.  You cannot remove the <default layer>.

To Rename a Layer
• Pull down the Options menu and choose Layers...  RR-Track shows the Drawing Layer Setup dialog. 

• Select   the layer you want to rename by clicking on it with the left mouse button on the layer data sheet. 

• Press the Rename button.  RR-Track shows the Layer Name dialog with the current name displayed. 

• Type the new name for the layer and press OK.  RR-Track renames the layer and updates the layer data 
sheet. 

• Press OK to dismiss the Drawing Layer Setup dialog. 

You can rename any layer except the <default layer> which cannot be renamed.
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To Change a Layer's Attributes
• Pull down the Options menu and choose Layers...  RR-Track shows the Drawing Layer Setup dialog. 

• Select   the layer you want to modify by clicking on it with the left mouse button on the layer data sheet. 

• Go to the Layer Attributes radio buttons and select the attribute you want from the choice of working, 
active, inactive, grayed, and hidden. 

• Press the Change button (this is important, RR-Track does not change the visibility attribute until you 
lock them in with the Change button). 

• Press OK to dismiss the Drawing Layer Setup dialog. 

You can change the visibility attributes of any layer, including the <default layer>.

Layer colors
Layers can have a default drawing and fill color which will override the intrinsic color for a track library (but not for 
the intrinsic colors used for accessories and objects).  In this manner you can change the default color of track 
by assigning the track to another layer, and then setting the default layer colors to that which you want for the 
track.  For instance, if you have two loops of track, one of which is the outer mainline and the other the inner 
mainline used for connection to yards, sidings, etc., you could place the track in the outer loop in a layer (called 
Outer Mainline) and the inner loop in a layer (called Inner Mainline).  If you assign the Inner Mainline layer a 
drawing color different from that normally used by the track library  then the two loops of track are drawn with 
different colors.  You can set the default layer drawing and fill colors by selecting them from the drop down lists in 
the Layer Colors group.  You can set track library colors from the Library Color page on the Global Options 
dialog.  Individual track colors can also be assigned, and these will override the color set for a layer. 

You can also set individual track drawing color using the Track Color command on the track shortcut menu.  The 
hierarchy of colors for drawing track  is:  track color, layer color, library color.

To Change a Layer's Colors
• Pull down the Options menu and choose Layers...  RR-Track shows the Drawing Layer Setup dialog. 

• Select the layer whose color(s) you want to modify by clicking on it with the left mouse button on the 
layer data sheet. 

• To change the drawing color, choose a color from the drop-down list box next to the D:; to change the fill 
color, choose a color from the drop-down list box next to the F:.  To set a custom color, choose 'cust' 
from the choices, and then press the ellipsis button adjacent to the color control.  This will bring up the 
Windows Color Chooser from which you can select a custom color. 

If you want to return the layer colors to 'none', i.e. no default colors, press the Reset button.

Rotating, Moving, and Adjusting Items
Most positioning of track, accessories, and objects in RR-Track is done with the mouse pointer.  RR-
Track also provides methods for precision positioning in small increments using the Quick Rotate and 
Quick Adjust dialogs.

Quick Rotate dialog:
When you right-click and choose Rotate from a shortcut menu, RR-Track shows the Quick Rotate 
dialog. 

The controls are straight-forward.  To rotate items, grasp the vertical slider control with the mouse and 
push it up or down.  The angle display shows the current rotation change and RR-Track dynamically 
updates the item’s orientation to show you what the is the new appearance.  You can also increment 
the rotation angle by clicking the + and - buttons just below the angle slider.

You can change the angle increment value by click on the  Angle button ( displaying the current 
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increment ) just below the + button.  The available increments are 1°, 2.5°, 5°, 7.5°, 15°, and 22.5°.  These 
correspond to 1/360, 1/144, 1/72, 1/48, 1/24, and 1/16 circles.

You can change where the center of rotation lies ( item origin or center ) by pressing the Org/Ctr button.  RR-
Track dynamically shows the rotation center on the item(s) you are rotating.

When you have reached a satisfactory rotation angle, press the Done button the dismiss the Quick Rotate 
dialog.

Keyboard Rotate
You can also rotate items by using the keyboard up and down arrow keys in conjunction with the CONTROL key. 
This is probably the quickest and fastest way to quickly orient items.

To Rotate Using the Keyboard

• Select   the items you want to rotate. 

• Hold down the CONTROL key and press either the up arrow key to rotate CCW or the down arrow key 
to rotate CW.  Each time you press the key, RR-Track rotates the selected items about the lead 
selection's origin an amount equal to the current setting of the quick rotate increment (see 
discussion above). 

• Repeat step 2 until you are satisfied. 

Quick Move dialog:
When you pull down the Action menu and choose Move, RR-Track shows the Quick Move dialog. 
This dialog is similar in its action to the Quick Rotate dialog, but translates the item(s) vertically and 
horizontally rather than in orientation.

The controls are straight-forward.  To translate vertically, click the up/down arrow buttons.  To 
translate horizontally, click the left/right arrow buttons.  Each click moves the items by one unit of 
the current snap size.  

To change the current snap size, press the Inc button.  This brings up the Snap Size dialog letting 
you choose a new snap increment.  Check the 1/2 step button in order to translate in half snap 
increment steps.

Press OK when you have finished re-positioning, or press Cancel to return the item(s) to their 
original position

Quick Adjust dialog:
When you right-click over nothing and choose Adjust, RR-Track displays the Quick Adjust dialog.  The 
Quick Adjust dialog combines the actions of the Quick Rotate dialog with that of the Quick Move dialog.

To Rotate:

Grasp the vertical slider control with the mouse and push it up or down.  The angle display shows the 
current rotation change and RR-Track dynamically updates the item’s orientation to show you what the 
is the new appearance.  You can also increment the rotation angle by clicking the up/down arrow 
buttons at the right of the angle slider.

You can change the angle increment value by click on the  Angle button ( displaying the current 
increment ) just below the + button.  The available increments are 1°, 2.5°, 5°, 7.5°, 15°, and 22.5°. 
These correspond to 1/360, 1/144, 1/72, 1/48, 1/24, and 1/16 circles.

You can change where the center of rotation lies ( item origin or center ) by pressing the Org/Ctr 
button.  RR-Track dynamically shows the rotation center on the item(s) you are rotating.

To Move:

To translate vertically, click the up/down arrow buttons.  To translate horizontally, click the left/right 
arrow buttons.  Each click moves the items by one unit of the current snap size.  

75



To change the current snap size, press the Inc button.  This brings up the Snap Size dialog letting you choose a 
new snap increment.  Check the 1/2 step button in order to translate in half snap increment steps.

Press OK when you have finished re-orienting and positioning or press Cancel to return the item(s) to their 
original orientation and position.

Simulating Train Operations
Adding Trains to a Simulation
You can add trains to your layout by either building new trains, or choosing an existing consist from either the 
stored consists, or recently added consists.  

To Build a New Train

• Press the New Train button, or pull down the Action menu and choose New Train, or right-click over 
nothing and choose New Train from the shortcut menu.  RR-Simulate displays the New Train Builder  
dialog. 

• Use the list of locomotives, freight, and passenger cars in the New Train Builder dialog to assemble a 
consist.  

• Press OK to begin the process of setting the new train where you need to place it on the layout, or press 
Cancel to abort adding a train. 

To Choose a Stored Train Consist

• Go to the Simulation status bar and move the cursor over the consist list.  Left-click to pop up the consist 
list. 

• Navigate through the consist list and left-click on the consist you want to add to the simulation.  This 
begins the process of placing the consist on the track at the desired position (see placing a train).   

• If you don’t want to add any of these consists, move the cursor outside the consist list; RR-Simulate 
hides the list. 

You can save up to eight permanent consists that you can recall and place on the tracks at any time.

To Place a Train on the Tracks

• Either use the New Train command to start construction of a new consist, or select a train from the 
stored consists.  RR-Simulate positions the cursor  at the center of the simulation. 

• Hover the cursor over the track location you want to place the end of the train.  RR-Simulate highlights 
( in green ) the track sections you need for the train.  If you get a beep, you do not have enough 
contiguous space for this train  ( or another train already occupies some of the track needed ) and you 
need to find another location. 

• Press the left-mouse button.  RR-Simulate places the train starting at the track section under the cursor, 
arranging the train consist from back to front. 

If you decide you don’t really want to add this train, left-click over a non-track location.  You will be asked if you 
want to try again, just choose No.  If this is an accidental miss, then choose Yes for another attempt.  Only one 
train can occupy a track section, if you try and place a train on an existing train, you will get a beep and be asked 
if you want to try again, or just cancel adding the new train.

To Remove a Train from the Simulation

• Hover the cursor over any unit on the train ( it changes to  when you are over a train). 

• RIght-click   to bring up the shortcut menu. 

• Choose Delete Train.  RR-Simulate deletes the selected train. 

Note:  deletions of trains are final, there is no undo.
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Running Trains
You can run all of the trains on your layout, one at a time.  A train must be attached to a cab in order to run it.  

Trains come in two flavors, live and dead.  Dead trains are just that, they don’t move ( you can make them live ). 
Live trains are connected to a cab and they can move.   So you must make your train live.

To Start a Train

• Hover   the cursor over the train you wish to make live and right-click the mouse. 

• From the shortcut menu choose Make Train Live.  If you have an already running train RR-Simulator 
will ask if you want to stop it.  Choose Yes. 

• RR-Simulator shows a cab window.  The controls on the cab window are used to run the selected train. 

• Press the Sim ON button to start the simulation clock. 

• Grab the throttle slider with the cursor ( hover over it and press and hold the left-button) and drag it down 
so that the speed no longer reads 00.  

• Release the throttle when you are at the desired speed.

RR-Simulate remembers the previous speed setting for existing trains.  If you terminated a train ( made it dead ) 
while at a non-zero speed, when you make it live the last speed setting is restored.  As soon as you press the 
Sim ON button the train will move at the previously set speed.

To Stop a Train

There are several ways to stop a train:

• Grasp   the throttle slider with the mouse and move it upwards until the speed readout is 00.  The 
simulation clock keeps running, and this train is still live 

-or-

• Press the Done button the throttle.  This will make this train dead, and stop the simulation clock.  

-or-

• You can also press the Stop sign on the simulation status bar or press the Sim OFF button, both stop 
the simulation clock.  The train is still live. 

To Throw a Turnout

You can choose the path through a turnout by toggling the switch throw state.  RR-Simulate shows the current 
switch throw state with a sold green or red path drawn from the turnout entrance to the turnout exit spur.  

• Hover   the cursor over the turnout until the  cursor appears. 

• Press the left-mouse button   to toggle to the next switch throw state ( this is back/forth between thru/spur 
track for two-turnouts and from spur-to-spur for more complex turnouts like three-way and four-ways). 

RR-Simulate treats slip-switches as a pair of back-to-back two-way turnouts.  You separately throw each side of 
the slip-switch by toggling with the left-mouse button.

Modifying Trains
You can modify existing trains by either (1) coupling trains together, or (2) uncoupling an existing train/consist.

To Couple Trains

• Slowly bring the moving train down the track to another, dead train. 

• When the route tracks overlap ( yellow outlines ) a warning flag appears on the cab.  

• When the running and standing train’s couplers overlap, RR-Simulate stops the moving train and asks if 
you want to couple these trains. 
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• Press Yes to couple them, the train list updates to reflect the new set of trains. 

RR-Simulate does not ( at present ) take physics into account and cause a train crash if you run the trains 
together at high speed.  You can only couple trains at their ends.

To Uncouple a Train

• Hover   the cursor between the train units where you want to break the train until the cursor changes to   . 

• Click the left-mouse button.  RR-Simulate breaks the train into two trains at this point, the Train List 
updates to reflect the new set of trains in the simulation. 

There is no undo command for coupling and uncoupling.  If you uncouple a train and then change your mind, 
you must re-couple them as discussed above.

Using Train Builder to Create Trains
In order to add a train to a layout simulation, you must first build it.  This is done using the New Train dialog..

New Train Builder dialog
When you choose to construct a new train rather that add 
an existing consist to your simulation, assembly of said train 
is carried out using the New Train Builder dialog, like that at 
right.

There are two sets of lists ( the left contains the available 
train units and the right contains the train units added to the 
new consist in the order in which they are linked).  Basically, 
you add train units one-by-one from the list of available TUs 
on the left to the train you are building on the right.  As you 
add TUs to your new train, Train Builder updates the consist 
in the right list.  Think of the two lists as a source of train 
units ( left list ) and a destination of train units ( right list )

Train Units

Train units are divided into locomotives, freight, and 
passenger categories.  Each of these may be expanded by 
left-clicking on the + sign in front of the category.

To Add a Train Unit to the Train

• Highlight   a train unit in the train unit list at left. 

• Press the Add>> button.  Train Builder updates the new train. 

Train units of any type may be placed in the destination consist.  When you add one of the steam locomotives 
( medium steamer: think 4-6-2 here; large steamer: think 4-8-4 here; 0-4-0 switcher) you also are adding the 
associated tender behind the locomotive.  These are added/subtracted as a pair, and you cannot uncouple them.

All train units physical sizes are calculated to scale, and are not actually assigned until a train is placed on a set 
of tracks.  You can make some choices in the default scale used for a given gauge track, this can be set in the 
Simulation Options dialog.  The other item that impacts both a trains length and its ability to traverse curved track 
is the coupler distance.   You can choose between using toy-train style couplers (longer coupler distance ) and 
scale couplers ( much closer coupling ).  See RR-Track v5 Help for further information.

To Remove a Train Unit from the Train

• Highlight the train unit you want to remove in the train list on the right. 

• Press The Rem<< button.  Train builder updates the new train. 
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To Change the Position of a Train Unit in the Train

• Highlight the train unit you want to move. 

• Press the ^ button to move it one unit towards the front of the train. 

• Press the v button to move it to the end of the train. 

Before you finish with your train, it is a good idea to give it a name that means something to you.  This is the 
name that the Train List uses, and appears in the information window when you hover the cursor over the train.

When you are finished creating your new train, press the OK button to begin the procedure of setting the train on 
the tracks.  Press Cancel if you don’t want to add a train at this time.

Track Laying Tips
(1) Use the zoom-in and zoom-out commands and the view stack.  I have found it to be effective to start with 
a large overview, not necessarily of the entire layout but a large fraction of it, and then zoom in to where I want to 
do some work, the return to my overview using the Last View command under the View menu.  Occasionally I 
move around the layout at high zoom factor using the scroll bars, or holding down the SHIFT key while moving 
the pointer near a border, but I find this less effective.  You can also move around the layout at the current zoom 
level by dragging the view box in the Overview window.

(2) Make use of the extended selection modes.  Remember, clicking once with the left-mouse button on a 
track section selects just that section; double-clicking with the left-mouse button selects that section and all of 
the contiguous track sections.  Which sections are chosen depends on the extended selection mode you have 
checked on the Options menu:  Selects Include Joints selects all of the physically joined track (the whole loop, 
sidings, etc.) while Selects Include Blocks chooses all of the electrically connected track (everything between the 
block break symbols); Selects Include Grades only chooses track either on the same grade or elevation.  If you 
haven't set any block breaks, then Selections Include Joints and Selections Include Blocks are identical in 
action.  Double-clicking on an extended selection  causes that selection to collapse to only the track section 
under the pointer.  By using these, and pausing for the Move cursor to come in, you can quickly go back and 
forth between choosing one piece of track and many pieces of track.

(3) Work with AutoJoin turned on. Always use the Autojoin mode, and override this as necessary by hitting the 
escape key as needed, to temporarily turn Autojoin off.  You may also override automatic joining simply by 
placing the newly added track far enough away from existing track to be outside the capture radius ( 6" for HO, 
12" for O-gauge, 18" for G-gauge, etc.).  Bring the ends that you want joined as close as possible, and then click 
the mouse.  Autojoin can fail if you are trying to add track in a densely populated area with a number of loose 
ends;  sometimes the end you aren't watching is closer to another section of track than the end you are 
watching, in that case the Step Back command under the Edit menu is your friend.  Remember that the Autojoin 
mode also applies to moving pieces of track.  If you get free ends within a track width, RR-Track will join them for 
you without you having to do this yourself.  This can be a problem in dense areas, such as switch yards, where 
you may want to turn this off, or rely on the aforementioned Step Back command, there are 20 levels of undo in 
RR-Track.

(4) Work with Allow breakaways turned on.  This makes it much faster to unjoin track from existing 
configurations.  You merely have to drag it 10 per cent or more of the screen size, and RR-Track will break the 
junctions for you.  When combined with Automatic Track Joining, which lets you put track back together simply 
by bringing the ends within one track width, reconfiguring layouts is much quicker.

(5) Work with automatic loop closing and proximity joining turned on.  I generally use these modes since 
mistakes are rare and it forces me to not try and bend too many track sections to close gaps bigger than a track 
width, minimizing the chances of designing a layout that has sections likely to cause derailments.   If you leave 
too big a gap, trains run in Simulation View will crash when they encounter a large gap, even if the track sections 
are  'joined'.

(6) Make use of Copy ,Paste, Duplicate, and Duplicate Parallel. I use this combination frequently to duplicate 
90° and 180° curved arcs of track in order to quickly throw a new loop together, or whole parallel sidings when 
designing a switch yard.  The Duplicate function is very useful for replicating custom bent or cut track sections 
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where you aren't interested in making a number of copies.  Duplicate Parallel is handy for creating sets of 
parallel tracks in switch yards, etc.

(7) Use multiple drawing layers.  Setting up even simple, small layouts with multiple layers is a real help.  You 
can put scenery in a layer, accessories in a layer, track in a layer.  In this way you can set the track layer to 
inactive so that you can see it but you can't select it so that it doesn't get in your way when you are setting up 
accessories and scenery.  This same thing is true for scenery:  you can draw some scenery, then set that layer to 
inactive, and then adjust track and/or accessory positions as necessary without the scenery getting in the way. 
See the essay on working with layers for more information.  The utility of having multiple layers cannot be 
overstressed;  we have seen many customer’s layout designs where all items were dumped in one layer making 
it difficult to edit effectively

(8) Use the Select List Window to tell you details on selected track. The select list window automatically 
totals the highlighted track sections, giving you the total length and the estimated number of average size cars 
this track will accommodate.  This is a handy way to find out if either a passing siding, or a reversing loop, is long 
enough to handle the trains you plan to run.  You can also use the listing to see if you have a track power section 
in an electrical block when you set the extended selection mode to Selects Include Blocks.  For track systems 
that have dedicated electrical connection tracks, this is a handy way to make sure you have adequately set up 
your track power connections.  By setting the extended selection mode to Selections Include Grades, you can 
use the Select List Window to show you the length of all of the track on a grade; this information can also be 
obtained by pulling down the Grades menu and choosing Information.  Of course the final judge of whether your 
layout will run properly is to use the Simulation View to run test trains.

(9) Use the Lock/Unlock functions to fix track sections you don't want to move.  One of the most irritating 
things is moving the wrong block of track accidentally.  If you have a hard, or a large loop and want to use this as 
a fixed reference for other track, then select it and choose the Lock command from the Action menu.  This will 
keep you from accidentally moving, deleting, or rotating these items.

(10) Add elevations and grades last.  It is usually better to design all, or almost all of the track plan before you 
begin raising/depressing track sections.  Introducing elevations and grades always adds to the complexity of the 
layout, and makes it more difficult to change design parameters later (short of removing the entire elevation, 
which you can do by using the Zero Track Height command). 

Building Your Layout to the Plan
Now that your plan, or plans, are done and you are ready to begin construction of your benches/roadbed and 
track work, it is worth spending a little time thinking about what can wrong during construction and how to avoid 
egregious errors between your carefully laid plans and the reality of your layout.

While a plan on paper looks reasonably simple to execute, it is frightfully easy for the best laid plans to go astray. 
For the most part, errors between your RR-Track plan and your actual layout can be traced to either (1) faulty 
bench work, or (2) faulty track joining.  

Bench Work.  Faulty bench work is generally simple to deal with.  First and foremost, make sure your bench 
units are square!  This is easiest to verify by using your tape 
measure and checking the diagonal measurements of each 
rectangular bench unit; they should agree within a small fraction 
of an inch (1/8 to 1/4).  Non-rectangular bench units are more 
difficult to verify, but they can usually be decomposed into 
blocks that have some rectangular characteristics;  these may 
be verified using the diagonal measurements ( for really odd-
shaped benches one needs to develop some surveying skills!). 
After individual sections have been verified, cross-
measurements across the assembled bench units should be 
checked against the layout plan in order to spot any slightly 
misaligned bench units.  Even if your bench units are placed 
against existing building walls, this is no guarantee that they will 
be square.  Most residential and commercial construction is out 
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of square by some amount --- sometimes rooms can be as much as 1/2 foot out of square. If you are 
constructing an L or C shaped layout the obvious cross measurement is between the legs of the C, or the two 
legs of the L.  It is important to make the bench work agree as closely as possible with the plan since bench 
edges are the obvious reference point when laying the track work.  At left is a simple C-shaped Lionel O layout 
with two of the obvious cross diagonals shown:  It is important to both cross-check the inside of the C and 
choose a longer diagonal, as shown, to check overall squareness.

Track Work.  It is equally, and arguably more, important to check the overall 'squareness' of the track work as it 
is for the bench work.  Track work errors are generally subtle, but can have very far reaching effects.  The most 
common error occurs when assembling multiple curves, either at the ends of loops or at 90° corners. 
Regardless of the track manufacturer, it is very easy to create angular joining errors when assembling the curves 
(you can even do this for straight runs if you are not assiduous in sighting down them, looking for misalignment). 
As an example, a 1° error when assembling 90° curves generates a 2 inch lateral error after just 10 feet of 
straight track (for larger layouts, the error is proportionally greater).  As these errors accumulate, the reliability of 
cut track measurements in the plan goes to nearly zero.  

The trick is to choose some part of the track work as an 'origin' or 'anchor' from which the position of other track 
sections is measured (usually areas where a number of switches are in close proximity, or joined to each other, 
is a good choice).  Almost every layout plan has some critical section of track work that can be carefully 
assembled and fastened down to use as an anchor point for triangulating all of the other track work.  In essence, 
you are going to have to do what real railroads do, survey the terrain your layout is on.  For the above layout, the 
back-to-back O31 switches at the lower left makes a good anchor.  

Assemble these and fasten to the bench work.  Next, assemble the curved track to the left of the two switches, 
as shown in cyan in the drawing below (don't fasten the track to the bench work at this time).

Now, go to your RR-Track layout plan and snap 
measurements between the track ends as shown. 
According to the layout plan, the two junction to junction 
measurements are 42.0 and 54.8 inches.  Get your handy 
measuring tape out and check to see if your partially 
assembled track measures as shown.  If it does not, pivot 
the curved track sections around until the cross-
measurements agree.

At this points fasten the assembled but not yet nailed down 
track to the bench work with a couple of screws (after all of 
the track is assembled and positioned you can go back and 
put in the rest of the screws).  

Next, keep adding track to the current leg as shown below, 
until you get to the top of the kidney-shaped curve; as before assemble the track but don't 
fasten to the bench work yet. 

As before, snap a pair of measurements between the anchor switches and the end of the 
curve, and the end of the track that you just fastened down and the end of the new curve. 
You should get measurements of 65.1 inches and 110.6 inches.  Pivot the newly added 
sections around, and then fasten with a couple of screws.  Keep going around the 
contiguous loop of track in this fashion, always choosing a two or more track junction 
measurements for purposes of verifying your track laying.  This is especially important 
when you have multiple levels of track, where one loop crosses over another.  In this case 
a further important measurement is the relative distance between track sections on the 
upper and lower layers.  As you verify and lightly fasten down consecutive track sections 
you will find additional cross-checks that you can employ in verifying your track work. 
Don't be too concerned about the effect of grades on the track junction positions:  the 
grades on train layouts are sufficiently small that any displacement error is as small, or 
smaller, than errors in track joining, and, in some cases, manufacturing tolerances..

Conclusion:  the important point to take away from all of this is that the only assumption 
RR-Track or any other CAD system can assume is perfect joining of track ( all track 
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pins/joiners are fully seated, all track junctions have a deviation of 0.0° from true, all track sections are 
manufactured to zero tolerances).  Any other assumptions will lead to even more errors.   It is up to the builder to 
follow the layout design, and cross-check the actual track positions during construction to those calculated  plan.
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Definitions and Terms
3D View Computer-generated 3D rendering of all of the visible items on your layout.  You 

can move around your layout and sample its appearance from all angles.

Accessories Components from a given manufacturer that, unlike track components, typically do 
not link together to form more complex structures.  Think buildings such as stations, 
and track side signals.  Some accessory components may also act as track.

Component 
View A look at your layout from the perspective of its component parts.  These are 

typically divided up by manufacturer but may also be sorted by layers.

Contour 
Height pts Individual or collective points manipulated in the Terrain Viewer that are used as a 

basis for interpolating heights in a layout design.  

Current page The page that is highlighted in the Page Preview window.  This is the page that will 
print if you click the printer icon in the Page Preview window.

Current 
printer The printer that any print requests will be spooled to.  You can change this using 

the Printer Setup dialog.

Current scale The scale that will be used when printing your layout.  This is the physical 
relationship between the size of your layout and its size on the printer page(s).

Dead train
Any train in Simulation view that is not under cab control.  Dead trains do not move.

Default printer This is the printer your PC uses if it has not been told to use another printer.  You 
set the default printer in Printers folder in your Control Panel.

Display list The Display List is a linear list of all of the items in an RR-Track layout.  They are 
listed in the order they are drawn, i.e. from back to front.

Draw color The color used to draw the rails and outlines of track components and outlines of 
objects.

edit handle These are the points that define a drawing object such as a rectangle, polygon, 
line.  When these objects are selected, edit handles appear as solid red circles that 
you can grab with the cursor and drag to re-configure.

Electrical 
block break Electrical block breaks create electrically isolated sections of track.  A single break 

will only isolate track if the other end of the track is a dead-end.

Elevated track
These are sections of track that are at non-zero heights, and are not part of a grade 
( not part of a contiguous range of track connecting track at one height to track at a 
different height).  Elevated track can have both positive (above base) and negative 
(below base) heights.

Extended 
selection 
mode

When selecting a track section, a double-click invokes an extended selection.  
Extended selections are all track physically connected to the selected track.  This 
may be further modified by restricting the extended selection to all track that is 
electrically connected ( i.e. in the same block) or all track that is height connnected 
(i.e. at the same height or in the same grade).  
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Fill color
The color used to fill solid parts of track and objects.

Global 
Options

These are settings in RR-Track that affect all master layout windows.  These 
include things like track joining parameters, plan view back ground colors, default 
library colors, autosave

Grade track
Track that is part of a contiguous range of track connecting track sections at one 
height with track sections at a different height.  While grade track sections may 
have non-zero height (and generally do) the adjacent track sections do not have 
the same height.

Hot Item list This is a handy list of up to 20 items from multiple RR-Track libraries that you can 
quickly access to add these components to your layout design.

Last Item list The Last Item list contains up to 10 of the most recently added, distinct, track or 
accessory items.  It is located at the right end of the Plan View status bar.

Layer
A layer is simply a grouping of track and objects which have some common feature 
(such as they are all on the ground level, or they are all on the upper level, or they 
are all on the inner loop, etc.).  Layers can be Working, Active, Inactive, Grayed, or 
Hidden.

Layout Bench 
Units

These are the rectangular and polygonal objects that form the bench arrangement 
of your layout design.  Generally track is laid on the bench units, but not in the case 
of track spanning spaces such as walkways.

Layout 
Options

These are settings in RR-Track that affect only the current layout.  These include 
things such as grid overlay size and color, snap sizes, unit system, joining and 
grade symbols, layout scale.   These can be set as system defaults for subsequent 
RR-Track layouts. 

Lead 
selection

This is the first item in a list of multiple track sections or objects.  The lead selection 
is drawin with bold outlines, and, for items that may be edited, drawn with edit 
handle.

Library
RR-Track libraries are typically composed of a single manufacturer’s 
track/accessory components in a given gauge/code.  For example:  Lionel O27 or 
Atlas c83 HO.   At any given time you can have one library active on the 2D Plan 
View Track/Accessory menu.

Live train A train in Simulation view that is under cab control.  Live trains do not have to be in 
motion.

Main 
application 
window

This is the window that appears when you first start RR-Track and serve as the 
‘container’ for all the other RR-Track windows such as master layout windows, 
overview windows, and status bars.

Master layout 
window

This is the container window that collects together the five views that RR-Track 
uses for your layout design.  Each of these ( Plan View, Component View, Terrain 
View, 3D View, and Simulation View) can be accessed by pressing the appropriate 
tab.

Menu Bar Bar containing commands running across the top of a window just under the 
caption.  Most ( but not all ) of these are sub-menus which drop further menus 
down when clicked.
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Module
Modules are self-contained collections of track, accessories, objects, and terrain 
that are treated as one big piece of track. They are unlimited in size and scope, but 
there may be only 12 exposed track ends.  Mostly useful for designing/maintaining 
modular train layouts.

Module List The Module List is a selectable list of all the modules you have in your module 
library.  

Overview 
window

The overview window, usually located at the upper right of the RR-Track main 
application window, shows an overview of your train layout whenever you switch to 
a plan view.  The overview shows the entirety of the layout regardless of the zoom 
factor in the plan view.  A small rectangle depicts the area of the layout current in 
the plan view; you may grab this rectangle with the pointer and drag it to change 
the viewport in the plan view.

Page margins These are the areas at the top/bottom and left/right edges that are not used for 
printing.  They can exceed the physical margins but not be less than them.

Plan View A 2D view of your layout, from above.  This is the window/view where you do all of 
your designing ( except terrain and benches).

Printing offset The X-Y distance between the lower left corner of the layout and the location of the 
printer’s page boundary.  For single page printing this should be zero.

Restore point
Whenever a change is made to a layout design, RR-Track creates a restore point.  
Changes including adding/removing track, moving track, joining/unjoining track, 
orienting items, etc.  You can back up incrementally through restore points to 
recover from a mistake.  Basically a global undo command.  RR-Track keeps track 
of the last 20 changes.

RR-Track 
clipboard

The clipboard is a general purpose holding area for any combination of track, 
accessories, and objects that you want to replicate somewhere else in your current, 
or another, layout design.

RR-Track 
Layout File A binary file system object, stored on your hard drive, USB drive, or optical drive, 

that contains all of the items needed to define an RR-Track train layout.

Shortcut 
menu Context-sensitive menu of commonly used commands accessed by right-clicking 

over items or an empty area of the layout.

Simulation 
View

An examination of your layout from the standpoint of railroad operation.  You can 
position trains/consists and use a cab to move them around, make/break trains, 
etc. to test the operational strengths and weaknesses of your design.

Skeleton 
mode A display mode for 3D Views that shows track with single-line supports and no 

terrain to give an idea of support structure needed.

Snap Size The spacing between imaginary points on a grid superimposed over a plan view.  
This limits the number of locations an object may be placed at ( such as on 0.25 
inch boundaries) simplifying positioning items accurately with the mouse pointer.

Tangent Line
These are dashed lines connected at one end to a track junction of your choice, 
and drug out as far as needed.  Tangent lines are drawn at the joining angle of the 
starting track end.  Once drawn, they are treated as any other line object and are 
not attached to the source track end.
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Tear-off menu A track or accessory sub-menu that you can position where you like and choose 
from as you would the track/accessory menu on the Plan View menu bar.

Terrain item A component item that is considered a terrain object.  These include all contour 
height points and all layout bench units.

Terrain Layer Special layer where RR-Track places all of a layout’s terrain objects such as layout 
bench units and contours.

Terrain View A 2D view of the bench work and terrain of your layout.  Track is shown but this 
view is used solely for design and configuration of your layout’s supports and 
terrain.

Track
Components from a manufacturer ( such as GarGraves Trackage) which have ends 
that mate with each other and compatible components from other manufacturers 
and are used to create a ‘road’ for your trains to operate upon.  Multiple track 
components can be joined together to form complex structures.

Train A linked set of train units ( cars ) that are controlled and move as a unit during 
layout simulation.

Train unit A single piece of rolling stock.  Multiple train units, when linked together, form a 
train.

Turnout
Track component that is used to divert a train from one exit route to another.  Most 
turnouts are two-way and have a single entrance track and two exit tracks.  More 
complicated turnouts are available with up to eight exit tracks and multiple entrance 
tracks.  Also referred to as a ‘switch’.

Working 
Layer This is the layer that you currently add items (track, accessories, or objects) to.  

Other layers may be visible, but this is the one you are ‘working’ in.
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